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Disclaimer and Limited Warranty 
 

This document and the software contained herein may not be reproduced in 
any fashion or on any media without the explicit written permission of 
MicroSurvey Software, Inc.. 
 
EXCEPT AS OTHERWISE PROVIDED IN THIS AGREEMENT, 
MICROSURVEY SOFTWARE, INC. SPECIFICALLY DISCLAIMS ALL 
WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE., TO DEFECTS IN THE 
DISKETTE OR OTHER PHYSICAL MEDIA AND DOCUMENTATION, 
OR TO OPERATION OF THE PROGRAMS AND ANY PARTICULAR 
APPLICATION OR USE OF THE PROGRAMS. IN NO EVENT SHALL 
MICROSURVEY SOFTWARE, INC. BE LIABLE FOR ANY LOSS OF 
PROFIT OR ANY OTHER COMMERCIAL DAMAGE INCLUDING, BUT 
NOT LIMITED TO, SPECIAL, INCIDENTAL, CONSEQUENTIAL, 
PUNITIVE OR OTHER DAMAGES.  
 
ALL LIABILITY BY MICROSURVEY SOFTWARE, INC. HEREUNDER 
IS EXPRESSLY LIMITED TO ANY AMOUNTS PAID TO 
MICROSURVEY SOFTWARE, INC. PURSUANT TO THIS AGREEMENT.  
 
Notwithstanding any provision of this Agreement, MicroSurvey Software, Inc. 
owns and retains all title and ownership of all intellectual property, including 
but not limited to all software and any and all derivative software; all 
documentation, manuals and related materials; all master diskettes or CD 
ROM’s on which such software may be transferred, and all copies of any such 
diskettes or CD ROM’s, and any and all derivative works of MicroSurvey 
CAD2002 by MicroSurvey. MicroSurvey Software, Inc. does not transfer any 
portion of such title and ownership, or any goodwill associated therewith; and 
this Agreement shall not be construed to grant any right or license, whether by 
implication, estoppel or otherwise, except as expressly provided herein. 
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Welcome 
 
MicroSurvey Software, Inc. is pleased to present our flagship product - 
MicroSurvey CAD2002.  This version adds features that our customers will 
love.  The Active Coordinate Editor, Active Traverse Editor, Active Batch 
COGO, and AutoCAD 2002 compatibility will help everyone.  
 
Our sales have grown more than 2000% since introducing MSCAD. This 
enables MicroSurvey to move forward faster to produce you a better product. 
Our success is due to your success with our software. 
 
We consider all the new features to be a Breakthrough. One of our beta testers 
reported a 50% timesaving since our MSCAD Pro 3.1 to produce a standard 
lot survey. This is what we are aiming for: a better, more enjoyable product to 
use that saves you time! 
 
Included with this program is almost 6 Hours of training movies. Movies make 
the printed documentation obsolete. That is why we reduced our manuals to a 
"Getting Started" book that contains the tutorials in a lay-flat book, and a 
"Program Guide". The Program Guide is more like a map into the on-line help 
system than a full reference manual.  Since the help system is electronic, we 
can treat it as a living document that can be updated with each service pack or 
new CD. 
 
We plan on introducing more exciting products for you in the next year. Watch 
our web site for news and updates on this and other MicroSurvey products. 
 
Yours truly, 

 
Darcy Detlor, 
President, 
MicroSurvey Software, Inc. 
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Addresses and Phone Numbers 
 

 
 
MicroSurvey Software, Inc. 
Corporate Head Office 
MicroSurvey Software, Inc. 
#110 – 2300 Carrington Road, 
Westbank, BC, V4T 2N6 
Canada 
 
Office Hours: 8am to 5pm Pacific Time.  
(Monday to Friday, except holidays) 
 
Sales & Technical Support 1-800-668-3312 
International Voice: +1-250-707-0000 
Fax: +1-250-707-0150 
 
Internet web-site http://www.microsurvey.com  
General Information: info@microsurvey.com 
Support E-Mail Addresses: support@microsurvey.com 
 
 

Eastern Technical Support Office 
MicroSurvey Software, Inc. 
3427 Hwy.#17 East, RR #2 
Corbeil, Ontario, P0H 1K0 
Canada 

Office Hours: 9:00am to 5:30pm Eastern Time.  
(Monday to Friday, except holidays) 
Technical Support Number: 1-877-752-2911 
International Voice: +1-705-752-2911 
Fax: +1-705-752-2133 
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Calling for Technical Support 
 
Preparing to Contact Technical Support 
 
MicroSurvey Software Technical Support is available to help you get the most 
out of your MicroSurvey CAD2002 program. The following information 
explains how to prepare for your call so that your inquiry can be answered 
promptly and accurately.  Take a few minutes before you place your call to 
check the printed documentation and the on-line help files to see if the answer 
is already at your disposal. Remember that there are several tutorials and over 
100 Screen CAM Movies that can also help explain some topics. Our Web site 
on the Internet can also save you time, please check it for assistance if you 
can.  If they do not help you then when you call please have the following 
information available if requested. Computer brand and model, CPU type and 
clock speed, other hardware attached to the computer such as plotters and 
digitizers, version of the program, operating system and version. 
 
Please make sure that you have all the steps you completed prior to your 
problem and can explain them to the technical support representative.  We 
may ask that you forward a copy of your data to us if we cannot find the 
problem immediately. 
 
Phone/Fax Support 
 
Introductory Support 
MicroSurvey offers a 90-day complimentary support period to all of our 
registered users, starting the date of purchase.  Introductory support is 
available Monday to Friday except holidays. To reach a technical 
representative you may use one of the following; 
 
Pacific Time Technical Support (Head Office): 8:00AM-5:00PM 
Technical Support Number: 1-800-668-3312  
International Customers Please phone: +1-250-707-0000 
Technical Support fax number: 1-250-707-0150 
 
Eastern Time Technical Support Office: 9:00AM-5:30PM 
North American Technical Support Number: 1-877-752-2911 
International Technical Support Phone Number: +1-705-752-2911 
Technical Support fax number: 1-705-752-2133 
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Yearly Support 
 
For clients who have had their original 90-day complimentary support period 
expire and feel that they will want on going support over the next year, we 
have a Yearly Support Contact option available.  This gives you the ability to 
contact us for technical support, as much as you require, and you pay a flat fee 
once a year. This option is not to be used in place of training but is to assist 
you on the occasions when you really need it.  The charge for the Yearly 
Support Contract is to be billed and paid for prior to the support commencing. 
This rate is subject to change, call for current rates. 
 
Electronic Support 
 
MicroSurvey maintains and provides support at no charge on our Internet 
Web-site at the following address: 
 
http://www.microsurvey.com/ 
 
This web-site has sections on Frequently asked questions, Technical Notes, 
Technical Specifications, and as required, free updates and program fixes, 
along with a lot of other helpful information.   
 
Training 
 
MicroSurvey Software, Inc. can provide training to you, in your office or in a 
classroom situation (where facilities and numbers allow).  
 
MicroSurvey has training staff that will travel to almost anywhere and provide 
you with the professional skills you require to operate your MicroSurvey 
CAD2002 program.  Please feel free to call and ask for a quotation or inquire 
about potential classroom situations. Your local dealer may also be able to 
setup or arrange a training session for you.  Contact our head office for more 
information about training. 
 

http://www.microsurvey.com/
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VIP Support Program 
 
Keep on top of the technology with MicroSurvey’s VIP Software Subscription 
program. You don’t need to concern yourself about staying current – we’ll do 
it for you. It’s the worry-free way to ensure you always have the best, most up 
to date software anywhere, and you know exactly how much it will cost. 
You’ll also receive unlimited technical support for your software. 
 
What are the advantages? 
 

• Get all upgrades to MicroSurvey CAD2002 sent to you automatically and 
Free!  

• Unlimited telephone support included. You always talk to a real person 
when you call MicroSurvey’s support line.  

• With VIP Service, we’ll always start the support process with a real person 
within 1 hour of your call. (during regular business hours*)  

• Always keep up to date with the latest technology. We give you priority e-mail 
notification of all bug fixes and updates.  

• You receive a 10% discount on your future MicroSurvey software purchases 
(from regular or promotional pricing)  

• No need to generate new purchase orders each time that a new upgrade is 
released. Your upgrade will come automatically.  

• Is your peace of mind worth pennies per day? These days, you can hardly 
buy a cup of coffee for that price, but that’s all you’ll pay for MicroSurvey’s 
VIP Subscription Program!  

• Buy up to four years’ Subscription at once. You’ll know exactly what it’s 
going to cost you, and you don’t ever need to check if you have the most 
current MicroSurvey software version.  

• We pay the shipping for new software. That’s another thing you won’t have 
to worry about.  

• When you deal with MicroSurvey, you always get great service. Imagine how 
good the service will be when you’re a VIP!  
 
Call our office for more details on the VIP program, or see the MicroSurvey 
web site. 
 
(*Note: 1 hour call back guarantee to start the support process is during Western Office hours) 
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Copyright Notices 
 
MicroSurvey CAD2002 
 
© Copyright 2001 
MicroSurvey Software, Inc. 
All Rights Reserved 
 
MicroSurvey Software, Inc. reserves the right to revise and improve its 
products as it sees fit. This publication describes the state of the product at the 
time of publication, and may not reflect the product at all times in the future. 
Use and disclosure of this product is governed by a licensing agreement 
printed. No part of this product may be disclosed or otherwise made available 
without prior written authorization. 
 
MicroSurvey is a trademark of MicroSurvey Software, Inc.  All other trade 
names or trademarks are gratefully acknowledged as belonging to their 
respective owners. 
 

MicroSurvey uses a version of the Felix Graphic Developer’s Engine™, 
Copyright Felix C.A.T. GmbH 2001 
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Hardware Requirements 
 
MicroSurvey CAD2002 operates entirely within Windows, and has no 
hardware requirements over and above those of Windows itself except as 
noted below. We suggest the following basic system as a minimum for 
efficient operation: 
 

• Pentium processor 
• 64 megabytes RAM (More if you are working in large drawings most 

of the time) 
• 100 megabytes free hard disk space (500MB if you wish to install all 

of the movies) 
• SVGA or better monitor 
• Video resolution set to 800x600 or better (lower resolutions may 

result in part of the pull down menus running off the bottom of the 
screen) 

• Mouse, digitizing tablet or other pointing device 
 
In order to use the data collector communication features, your system will 
also need an external RS-232 serial port or a USB connection for best 
performance with MicroSurvey FieldGeniusTM. 
 
In order to get printed output, you will require a printer or plotter configured to 
work in your Windows environment.  We recommend obtaining the most up-
to-date printer/plotter drivers off of the manufacturers Internet web site. 
 

Software Requirements 
 
MicroSurvey CAD2002 is designed for use with Windows 95, Windows 98, 
Window NT (4.0SP3+), Windows 2000, or Windows XP. Note: Windows XP 
users must have Administrator’s rights.  Most of the functions and routines are 
called from pull down menus or dialog boxes, which are added to the CAD 
menu system.  Command line entry and Toolbars have also been included to 
allow faster entry.   
 
When using a digitizing tablet you will require the current WINTAB driver for 
your tablet, and it must be installed and configured in Windows. 
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Getting Started 
 

Help System 
 
The help system is continually updated to keep current with all the 
advancements and new commands that are added on a regular basis.  The help 
file also has Tutorials, Important Phone Numbers, Copyright Information, and 
Much more.  Be sure to look through the whole help file as it will always be 
more current and comprehensive than the manuals. 
 
A few tips about using Help: 
 
You can find Help using any one of these 3 methods: 
 
1. By clicking on the HELP button available on most dialogs within 

MicroSurvey CAD2002. This will take you to the help topic on the 
command currently in use. 

2. Quick tips are available on most dialogs within MicroSurvey CAD2002 
by using the What's This? Help.  

3. Access the Help System from the top of the Help menu or using the F1 
key. 

 
Have a look at the next image. The Help is arranged in the same basic order as 
the Menus.  
 
• Notice that the topic for drawing a LINE is displayed. If you had located 

this topic using the Index or Search options, you should flip to the 
Contents option to locate the command in the menu system. 
 

• Notice that the keyboard command is shown where possible as well as the 
corresponding toolbox / Palette button. 
 

• The Back button will take you to the last page viewed and the forward and 
back arrows help you to navigate through the Help system in topic order 
as shown in the table of contents. 
 

• Always look for the vertical scroll bar on the far right hand side. It's 
presence indicates that there is more information below that is not 
currently visible. Some topics are several pages long! 

 



 

 
 

What's This? Help  
The little  in the corner of the dialog box allows you to pick it then pick 
the portion of the dialog that you want help on while running the command. 
 
Use this to find out about any portion of the dialog box on screen. 
 

Startup and Overview movie 
 
This is a long one so grab some popcorn and get ready for a full tour of 
MicroSurvey CAD2002! You can start this movie from the Project Manager, 
or from the Help Menu under MicroSurvey Movies. 
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Product Registration Options 
 
Now that you have tested the program in detail and you have decided to 
purchase, you need to register the product.  We have made this job as easy and 
painless as possible by allowing you to register from inside the program.  We 
also allow you to erase the registration file in case of difficulty but this should 
only be done under the direction of a MicroSurvey Employee. These options 
are at the top of the MicroSurvey Pulldown menu: 
 

 
 

Enter Registration Password 
 
This command allows you to enter the MicroSurvey CAD2002 registration 
process.  You will be shown the Registration form which we require you to fill 
out in order to receive your password to convert the program into a fully 
enabled mode.  This is only needed upon initial installation, or after you have 
run in Demo Mode, and you have decided to purchase. 
 
If the product is already registered then you will simply see this dialog box. 
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Delete Registration File 
 

  
 
This command will erase the Hidden, System file that contains your 
registration password.  Be VERY careful with this option and do not pick it 
unless you are having a problem with the password.  After deleting this file, 
the next time you start MicroSurvey CAD2002 You will be presented with the 
Registration form. 
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The Convertible Demo 
 
MicroSurvey CAD2002, like other MicroSurvey Software, Inc. products, is 
marketed in the form of a "Convertible Demo", which lets you try out all its 
functions without buying a copy. We encourage you to redistribute copies to 
anyone in complete and unaltered form. This copy will be fully functional in 
every way but will shut down after 30 days. 
 
Converting to a fully functional system 
 
If you decide to purchase the system, you can convert it to full operation by 
means of a password supplied by MicroSurvey Software, or an authorized 
dealer. When you initially start up the program, you will see the following 
dialog box: Choose one of the following Options: 
 

 
 
If you are just testing the program out then you will see the following dialog 
box, after you pick demo mode. 
 

  
 
If you choose Register Program you will see the following dialog box: 
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Fill out the information. When you press the OK button, the program will 
write the information along with the Key number into a file called 
REGISTER.TXT that will be located in the C:\MSCAD2002\MSCAD 
directory. Print this file and FAX (250) 707-0150 or Email it to 
register@microsurvey.com. 
 
Register Program 
 
As soon as payment arrangements have been made, you will be given a 
password. The next time you load MicroSurvey CAD2002 select the option 
"Password". You will be presented with a dialog box to enter the password. 
 

  
 
After the password has been entered you will see, 
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Hardware Lock Version 
 
MicroSurvey CAD2002 is available in a hardware lock version. This version is 
primarily meant for International customers but can be purchased by Canadian 
and American customers if desired. The Rainbow Software Sentinel Hardware 
Lock is a method of protection that replaces the software password required 
for the program.  Using the hardware lock can provide greater freedom by 
allowing you to install the MicroSurvey CAD2002 program on several 
computers but only have one licensed copy. You could simply transfer the 
hardware lock to the computer that requires it. The other computers will not be 
able to run the program without the hardware lock. This option is great for 
home and office situations.  You must secure the hardware lock to your 
parallel printer port on the rear of your computer. Make sure the power is off 
before connecting or removing any cables or other devices from your 
computer.   
 
To tell the program that you are using the hardware lock instead of the 
password protection system you must install the Sentinel Pro Drivers. The 
drivers are included on your CD. 
 
STEP#1 
For Windows 95 or Windows 98: 
Change to the  \Sentinel\Win_9x directory and run SENTW9x.EXE.  Pick on 
the Functions pull down menu (near the top left of the screen) and Pick 
INSTALL.  The following dialog comes up to confirm the location of the 
drivers on the CD – simply press enter to accept this. 
 

 
 
Then exit out of the driver program.  Your drivers are now installed for 
Windows 95/98. 
 
For Windows NT4  Windows 2000 Windows XP: 
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Change to the  \Sentinel\Win_nt directory and run INSTALL.BAT.  This batch 
file will determine which type of computer your NT is installed on and run the 
appropriate program to install the drivers.  Follow the prompts to install the 
drivers. 
 
STEP#2 
After installing the appropriate drivers, as shown above, you need to copy 
two more files to make MicroSurvey CAD2002 fully functional with the 
Hardware Lock. 
 
The hardware lock version of the main MicroSurvey CAD2002 program DLLs 
are in a directory on the root of the CD called \HWLOCK.  We found that 
some computers were having problems with the hardware lock code if they 
had non-standard serial ports, so we produced a special copy of the DLL for 
hardware lock machines.   
 
Before you can use the hardware lock version you need to copy MSCAD.DLL 
and QS.DLL from the \HWLOCK directory on the CD, into your 
\MSCAD2002\PROGRAMS directory on the computer, making sure that you 
DO replace the existing files. 
 

Transferring the License to Another Machine 
 
Occasionally it is necessary to move the program to a newer machine.  
MicroSurvey CAD2002 has the ability to generate a transfer password so a 
new machine can “take over the license from an older machine. This will 
COMPLETELY DISABLE the program on the old machine, so it should 
ONLY be used if you do not plan on running MicroSurvey CAD2002 on the 
old machine.  If you wish to keep it on the old machine, then you will need to 
purchase an additional license.  You cannot return the license to the old 
machine at a later date, without getting assistance from MicroSurvey 
Software’s Head Office. 
 
To transfer the license to a new machine: 
 
1. Begin the installation process on the new machine, following the 

instructions above for a Fully Licensed Version. This install on the new 
machine will generate and display a Key Number near the bottom of the 
Customer Registration dialog. 

 
2. On the old machine, run the command from the MicroSurvey pull down 

menu: Product Registration Options-> Transfer License to Another 
Machine. The following dialog box will be displayed: 

 



 

  
 
3. Enter the key number from the NEW machine into this dialog. When you 

press Ok you will receive another warning that you are about to disable 
MicroSurvey CAD2002 on this old machine. 

 

  
 
4. If you wish to do so, press Ok again, and you will receive the password 

for the NEW machine. 
 

  
 
MicroSurvey CAD2002 will Exit at this point. Go to the new machine and 
enter the password.  If you attempt to reload the program on the old machine, 
the program will advise you that the license has been transferred to another 
machine. If you wish to purchase a license for this machine, call our office and 
we can give you an unlock code that will re-enable this machine to run 
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MicroSurvey CAD2002.  You cannot transfer the license back to the old 
machine – it is a one-way transfer only. 
 



 

Program User Interface 
 

The desktop contains a series of standard elements. These are the menu bar, 
the toolbars, the properties bar, and the status bar. 

In addition, the desktop may also contain several palettes. 

The following picture shows a possible standard variant of the desktop. See 
the on-line help system for more details.  You can pick on the picture in the 
help system for information on each part of the screen. 
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Desktop Configuration 
Command: DESKCONF 

Modification of the Desktop Layout 
The DeskConf command displays a pop-up menu that lets you rearrange the 
desktop. The menu allows you to determine the layout of the command line, 
option menu or bar, property bar, left toolbar (control panel), and status line. 

  
The Desktop Layout pop-up menu 
 
Command Line 
The command line can be placed at the top of the screen (below the menu bar), 
or at the bottom of the screen (above the status line). If you are an advanced 
user familiar with the program's command set, you might even turn off the 
command line. 
 
Option Bar 
The options menu can be displayed as a bar (under the command line) or as a 
floating menu. Once again, if you are an advanced user familiar with the 
command options, you can turn off the option menu and bar. 
 
Properties 
The property bar can be turned on or off. We recommend you turn it on. 
 
Left Toolbar 
The control panel (also known as the left toolbar) can be turned on or off.  
 
Status Bar 
The status bar can be turned on or off. We recommend you leave it on. 
 
Customizing Toolbars 
The toolbars (we call them palettes) assemble buttons that represent a common 
set of commands, or sequence of commands.  
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Dragging an Icon to a Toolbar 
You add command icons (or symbols) to a toolbar by simply dragging a button 
from a palette into a toolbar. Follow these steps: 
 
1. Open a palette containing the icon of a command that you want to place 

into a toolbar. Type the PALMAN command and select palettes from the 
Palette Manager. 
 

2. Hold down the left mouse button on the icon you want and drag the icon 
to the desired location within a toolbar. 
 

3. Release the left mouse button to drop the icon at that position. 
 
Adding an Icon to a Toolbar 
 
Follow these steps to add an icon to a toolbar: 
 
1. Right-click the button you want to place a new icon on. The following 

dialog box opens:  
 

  
 
Specifying the properties of a toolbar button 
 

2. Specify the command name, the bitmap file, and the messages for the 
ToolTip of the button and the help string displayed in the status bar. 
 

3. Click OK. 
 
If you want to protect the button from being overwritten, enable the Protected 
check box. 
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Deleting an Icon from a Toolbar 
 
You can delete an icon from the toolbar only when the button is not protected. 
You unprotect a button by right-clicking the button and then disable the 
Protect option in the Toolbar Configuration dialog box.  
Follow these steps to delete an icon from a toolbar: 
1. Hold down the left mouse button over the icon you want to delete. 
2. Drag the icon onto the drawing window, or to the background area of the 

drawing area of the desktop. 
3. Release left mouse button. 
 
The icon is removed from the toolbar. You may then place another icon onto 
that button. 
 

How to open the Desktop Configuration pop-up menu 

• You can call the Desktop Configuration menu by typing the 
DESKCONF command. 

• Also, you can open the Desktop Configuration pop-up menu by 
clicking the right mouse button in a "non-functional" area of the 
program's desktop. Such area is either the background area upon 
where the drawing viewports are displayed or areas in the property 
bar, context bar, or toolbars that are not covered by buttons or drop-
down lists. If necessary, reduce the size of the current drawing(s), 
cascade the drawing(s), or minimize the drawing(s) to get some free 
space of the drawing area background. Right-click to this area to open 
the Desktop Configuration menu. You exit this pop-up menu by left 
clicking to some other area or component on the desktop. 
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Workflow 
 

How MicroSurvey CAD2002 Works 
 
MicroSurvey CAD2002 creates a database that contains connectivity 
information, coordinate locations, descriptions, traverses, bearings, and 
distances. The program tracks the entities stored in the CAD drawing by their 
handle numbers. Many files are created to store this information.  
 
In order to limit the number of files you need to work with, we combine the 
data files into one file when you close the MicroSurvey CAD2002 job. The 
database is stored in a file with the extension .MSD.  This file is stored 
wherever your CAD drawing is stored. When you are running MicroSurvey 
CAD2002, this file is renamed to the extension .MBK, and it serves as an 
emergency backup file. The MSD file is expanded into a directory that has the 
same name as your job with the extension .MSJ. If you are running 
MicroSurvey CAD2002 and you look in the directory where your job is 
located, you will see this .MSJ subdirectory.  When you close the 
MicroSurvey CAD2002 job by exiting or closing the drawing, then the files 
will be automatically compressed into one file, and the directory will be 
removed.  
 
MicroSurvey CAD2002 has an Automatic backup timer that will save the 
drawing and the database regularly. In the event that the .MSD file cannot be 
opened, the system will automatically attempt to open the .MBK file. If neither 
file can be opened (very unlikely), then the system can still reconstruct the 
coordinate database and the connectivity database directly from information 
we store in the drawing.   
 
If you have only the drawing created in MicroSurvey CAD2002 and no 
database for whatever reason, we can still recover everything from the drawing 
automatically upon opening the FLX file. You don’t have to do anything; we 
do it all automatically for you.  The drawing must have been created in 
MicroSurvey CAD2002 or completely re-scaled or refreshed in MicroSurvey 
CAD2002. 
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Workflow 
 
This summary is intended to provide an introduction to users who are not 
familiar with MicroSurvey CAD2002and outlines the steps necessary to 
prepare a survey drawing. 
  
Generally you will be starting with data from a data collector, from field notes, 
or from direct COGO data entry. You may also extract data from existing 
CAD drawings.   
 
When you first start MicroSurvey CAD2002 you must either open an existing 
drawing (.flx, dwg, or dxf file) or start a new one. Opening an existing 
drawing will automatically open and link to the associated MicroSurvey 
CAD2002 coordinate database (.msd file). If you start a new drawing, a new 
MicroSurvey CAD2002 database file will be automatically created.  
 
On new projects, you will be shown the Main Job Defaults. You should fill out 
the dialog box and set up the basic job information and scale factors.  Next you 
will need to set the System Toggles to choices appropriate to the job.  Where 
you start next depends on the data source. Most options can now be found on 
the Assistant or in the MicroSurvey pull down menus.   
 
For data collectors you will either download directly from the data collector 
using the choices on the Data Collector Communication menu or reading a file 
from the data collector using the choices on the Data Collector File Analysis 
menu.  For field note entry you will use the Enter Traverse command on the 
Traverse Coordinating & Balancing menu.  For manually entered COGO data, 
you will use the COGO command from the Points/Lines/Curves menu. (you 
can simply type COGO if you wish as a short cut)  For point, line and curve 
data in a pre-existing CAD drawing, you will use the Auto Add Points to 
Objects command in the Coordinate Point Utilities menu.   
 
When you enter a traverse in MicroSurvey CAD2002, either by downloading a 
data collector or by manually typing in the data, the program creates a traverse 
database.  Each traverse is contained in a separate database. The databases are 
stored in the project directory when MicroSurvey CAD2002 is loaded and 
running, and they are automatically compressed into the .MSD file when 
MicroSurvey CAD2002 is unloaded.   
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There is a set order that you should use when working with raw data 
information in MicroSurvey CAD2002: 
 
1) Manually enter, load from a file or download the data into the traverse 

file. 
 

2) If you are entering the data manually, and the Auto Coordinate toggle is 
ON, then points will be coordinated and drawn onto the MicroSurvey 
screen as you enter the data. If you download the data from a data 
collector, any coordinates in the ASCII file will be entered immediately in 
the coordinate database. The raw data shots read in from the data collector 
ASCII file are NOT processed into coordinates until you select 
Recoordinate Traverse. 
 

3) Edit the raw data to correct any known errors by selecting Edit Traverse 
File. 
 

4) Enter any starting setup and backsight coordinates into the coordinate 
database before you attempt to coordinate the traverse. Use Store and Edit 
Coordinates on the Coordinate Point Utilities. 
 

5) Select Coordinate Traverse. This is the program that analyzes the raw data 
and computes the coordinates for all the raw data shots taken in the field. 
 

6) Use the Active Coordinate Editor and examine the MicroSurvey drawing 
for errors. 
 

7) Correct errors using Edit Traverse File and Recoordinate the traverse.  
When you run Recoordinate traverse on a traverse that has already been 
coordinated, you will trigger a point protection alert for each point 
processed.  To avoid this, turn off Point Protection in System Toggles, 
then the entire traverse will then be process without interruption. 
 

8) To see the line work for the traverse go to the Show Traverse Graphically 
command. 
 

9) Use the Compute Closure option to analyze the closure of the traverse. 
 

10) You may balance the traverse using one of several options, Angle 
Balance, Transit Balance, Crandall's, Least Squares, or Compass Balance. 
See Traverse Balancing for details. 
 

11) If you detect an error after balancing, you can revert back to the original 
or edited traverse and re-coordinate it again starting at step  
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For more examples of MicroSurvey workflow, please see the Tutorials 

 
Files types used by MicroSurvey CAD2002 

 
An outline for how MicroSurvey CAD2002 saves your drawings. 
 
A suggested folder name to save your jobs in might be C:\JOBS2000.  Then 
create a new one for 2002, etc. as desired.  We do NOT recommend that you 
place your jobs in our MSCAD2002 folder or in a sub folder under 
MSCAD2002.  Also - try and keep your folder names simple and not too many 
levels deep.  The job name should also be kept simple.  Under this folder you 
can have many jobs, each with it's own name.  When you start a new job or 
open an existing job, there are several files created automatically on the hard 
drive in the folder you selected. 
 
Below is an example of what files are created by MicroSurvey - using the file 
JOBNAME. 
 
Standard Job Files: 
Drawing File      jobname.flx or jobname.dwg 
Database File      jobname.msd 
 
Temporary Folder   <dir> jobname.msj 
 
Backup of Drawing file   jobname.bak 
Backup of Database file   jobname.mbk 
 
Note that for MicroSurvey CAD2002 you can set the program to store all files 
in DWG format from R12-R2002.  
 
When the Job is opened, the Drawing file goes into your computer memory, 
and the Database file is opened into a temporary folder.  The temporary folder 
has the same name as the JOB but has an extension of MSJ attached to it. 
 
You should not touch this folder and nothing should be placed in here except 
via the automated routines in our program.  We place this temporary MSJ 
folder in the same location on the hard drive as the job. This is why you 
cannot open a job from your floppy drive as it is too slow and does not 
have enough space! 
 
When you save the job, the contents of this folder are compressed and saved 
into the MSD file. If you exit the program this folder is erased, along with 



 

everything in the folder. This is why you should not place anything in this 
folder yourself.   
 
Each time you save the job you are taking the current information in memory 
and saving it to the FLX or DWG file.  Then we take the current contents of 
the MSJ folder and save it to the MSD file.  At the same time, if a FLX/DWG 
and MSD file already exist then we rename the copy already on the hard drive.  
The FLX/DWG file becomes the BAK file, and the MSD file becomes the 
MBK file.  This way you have backups of your work in case you need them.  
If a BAK file and MBK file already exist then they are simply replaced by the 
newer copy. 
 
As you work through a job you will create other files as well.  The LOG file is 
saved automatically in the same folder as the FLX/DWG file.  This file 
maintains a record of the survey commands run with their output.  There is a 
toggle to control this file as well as the ability to blank the file.   
 
If you do any work in the Modeling menu and you decide to save your 
surfaces then you will create a QSB file.  We suggest you save it in the same 
folder as the FLX file as well.  This QSB file is not automatically saved and 
must be done manually - also for loading it must be done manually each time 
you wish to use it in the job. 
 
The program will also save Raster functions in the FLI file and any Helmert's 
Transformation data sets in the HELMERTS.BIN file. 
 

  
 
Other files can be generated, depending upon what you do in the program.  If 
you download a data collector you may have a Raw data file or a Coordinate 
file.  You must tell us where to save these files on the hard drive and in some 
cases even what to call them.  We might suggest one of two locations to place 
these files.  First might be a folder called C:\DOWNLOADS, it would be at 
the same level as JOBS2000 but separate.  Second you may want to place the 
DOWNLOADS folder under the JOBS2000 folder producing,  
C:\JOBS2000\DOWNLOADS as a location to save all your download files.  
This is up to you.  
 
Depending upon what type of collector you are using, the file names may be 
sent directly from the collector to our program.  Other brands will require you 

Getting Started in MicroSurvey CAD 2002  27 



 

 28  Getting Started in MicroSurvey CAD 2002 

to provide the name and extension.  If you are providing the name then be sure 
that it reflects your job name, is unique and has an extension on it. 
 
Suggested extensions might be RAW for raw data files and COR or TXT or 
ASC for coordinate files.  (TDS collectors use RW5 for raw files and CR5 for 
coordinate files, and both use the name stored in the collector automatically)  
Or course there are many other files that you can create with MicroSurvey, 
they can range from Report files and closure files, to ASCII exported files and 
upload collector files, and even Legal Descriptions.  You can name these 
anything you desire but we recommend that the naming structure be consistent 
and use appropriate extensions, and always keep the files together in the 
JOBS2000 folder so you know where the files are.  We allow you a lot of 
flexibility but you have the ultimate control and if you do not know how to 
work in Windows to create the correct folders then you may wish to receive 
some training in this area before jumping in too deep. 
 



 

MicroSurvey Assistant 
 

These menus are designed to “assist you in developing a job from first 
principles to completed survey drawing, with minimal knowledge by the user.  
 

Assistant Main Menu 
 
The main menu is structured so that no matter what you have to do to start a 
job, you should be able to do it directly from here.  
 
As you move your mouse around on the assistant, you will see different 
pictures appear for each of the buttons.  They are there to help you remember 
what each button will do for you.  Picking on one of the buttons will take you 
to a second level of menus that provide more programs.  Investigate them all 
so you will know where to find what you need. 
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Assistant - Set Program Defaults 
 
  
Use this dialog to modify the 
Program Defaults. 

 
You can modify the Main Job 
Defaults under the General button.  
The Toggles are also available to 
you from this dialog, along with all 
the other defaults used to setup 
such things as distances, 
elevations, point numbers, etc.  The 
CAD Settings and Drawing Units 
will display the appropriate options 
allowing you to set the working 
units, grid, snap, point style, 
OSNAPs, trim radius, highlighting 
options, mirror text options, and a 
whole lot more.   

 

 
 
 

Assistant – FieldGenius Tools 
 
MicroSurvey’s new FieldGenius 
line of data collectors has a super 
productive and easy to use 
interface. Our extensive experience 
with a variety of manufacturer’s 
data collectors ensured that when 
we built an interface, it would be 
better than anything on the market. 
Our ActiveSync integration makes 
data transfer and import as painless 
as possible. 
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Assistant - Send/Receive Data from Data 
Collector 

 
 

 

This short menu assists you if you are 
downloading a file from your data 
collector to the computer or uploading a 
file from the computer to your data 
collector. 

 
 
 
 

Assistant - Import ASCII File or DC File 
 
  
Another method of importing point 
data into MicroSurvey CAD2002 is 
via an ASCII file.  This file would 
have information like; Point 
Numbers, Northings, Eastings, 
Elevations, Descriptions, each 
describing a point, and in one of 
several different formats in a text 
file known as an ASCII file. 
 
You can also read a data collector 
file that you downloaded 
previously, incorporating the data 
into your job. 
 
Several other tools have been added 
to this menu to allow you to join 
points by linework in an automated 
method.   

 

 
 

Assistant - Traverse Calcs 
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This menu option allows you to 
manually enter, edit, list, re-
coordinate, or show a traverse.  It 
also allows you to compute 
closures and balance the traverse. 
 
Data collector files are also 
considered to be traverses and 
therefore you have the ability to 
manipulate those files as well.  
Especially useful for the data 
collector file is the Re-coordinate 
traverse option which is required 
to calculate coordinates from the 
original Raw data saved in your 
data collector files. 

 
 

Assistant - COGO/Calculating Programs 
 
Here are the shortcuts used by 
almost everyone.  COGO is one of 
the most used portions of 
MicroSurvey CAD2002.  Working 
with lines and curves, generating 
streets from centerlines, and then 
taking those streets and adding 
blocks and lots to create a 
subdivision.  Finally this section 
allows you to take the lots and 
place houses on them, with 
labeling of the lot numbers and 
areas.    
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Assistant - DTM/Contouring/Volumes 
 
 
For the customers that need to take 
their survey drawings a step further 
and create surfaces from the point 
and line data, we have made the 
transition to the Modeling program 
as seamless as possible.  The more 
common activities of creating 
Surfaces, TINs, Contours, and 
continuing further to calculate 
volumes between multiple surfaces, 
are all made available to you here 
along with many other options. 

 
 

Assistant - 3D Design Programs 
  
This menu is used for the more 
advanced design sections of 
MicroSurvey CAD2002. These 
routines are explained in detail in 
the Help system. 
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Assistant - Label Drawing 
  
This menu is a short cut to all of 
your text and labeling routines.  
Many of the Toolboxes can be 
accessed here to help make rapid 
labeling possible.  Other routines 
such as line and curve tables and 
area calculations are added to assist 
you.  The toolboxes, or palettes, 
display many options and can be 
left on the screen for future usage.   
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Data Collector Tutorial 
 
 
Because of the size and complexity of this tutorial we have broken it down 
into 11 smaller steps to make it easier for you to follow. 
 
Step 1) Starting the Job 
 
Step 2) Importing a Data Collector File 
 
Step 3) Viewing the Drawing 
 
Step 4) Line Connection – Z-coding 
 
Step 5) Create Surfaces 
 
Step 6) 3D Viewing and Advanced Rendering 
 
Step 7) Cleanup of Screen 
 
Step 8) Quick Contours 
 
Step 9) Setting up a Boundary 
 
Step 10) Final Contours 
 
Step 11) Labeling Contours and Saving Your Work 
 



 

Starting the Job 
 
In this introductory tutorial we will load a data collector file and annotate the 
points, connect the break lines, then build a contoured topographic model of 
the surveyed site.  We will start with a new empty drawing and project and 
build everything from scratch. 
 
To begin, start a new drawing by going to the MicroSurvey Project 
Manager, found under the File pulldown menu. 
 

 
 

Then pick on the NEW button to start a new job. 
 
Then fill in the name of the job and call it SOKKIA.FLX,  
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Pick on the OPEN button. 
 
Next you will see the following dialog box. 
 
Set the scale and other settings as shown below. 
 

 
 
Pick on the OK button to continue. 
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Importing a Data Collector File 
 
You will see the MicroSurvey Assistant on screen (if you do not, pick on the 
Assistant button from the option bar) 
 

 
 
From the assistant pick the Import ASCII File or Data Collector File button. 
 

 
 
Then from this dialog pick the Import Data Collector ASCII File button. 
 

 38  Getting Started in MicroSurvey CAD 2002 



 

 
 
Now select the button that says Sokkia 20/22/24. 
 
You will then be presented with the Toggle Check dialog box to confirm that 
they are correct or to change them if required. 
 

 
 
Pick the OK button to continue. 
Next you will see the following dialog. 
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Change it to the \MSCAD2002\Tutorial folder and pick on the file named 
SOKKIA.RAW. 
 

 
 
Then pick on the OPEN button to continue.  This is a Sokkia coordinate data 
collector file. 
 
Then you will see the following dialog box: 
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Select New Traverse, because this is a new traverse database.   
Enter Sokkia as the new traverse name in the following dialog box, and pick 
the SAVE button to continue. 
 

 
 
Fill in information about the job in the dialog box below and then pick the OK 
button. 
 

 
 
This collector file contains only coordinate information and therefore all the 
points are passed directly through to the database and screen. As the data 
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points are loaded, you will see the data collector records scroll by in the text 
window, but because the view is not over the site, you don’t see anything until 
the end when the program automatically does a zoom extents for us.   
 
You will see this dialog box in the middle of the screen. 
 

 
 
Pick on NO 

 
 
And NO. 
 
Then when the Assistant menus come back on screen – hit EXIT on each one 
until they are removed from screen and you are left with just the job on screen.  
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Viewing the Drawing 
(This step of the tutorial is to help show the points in the job in a view that 
will help you understand the program.  This entire step is not required when 
doing your own jobs later) 
 
You will see all of the labeled points from the job.  If you zoom in on a couple 
of points, they would look like this.  
 

 
 
(The zoom commands are found on the left side of the screen where the 4 blue 
arrows point up, down, left and right) 
 

 
 
The annotation (text) is drawn at the current elevation (usually zero), but the 
points are drawn at their actual 3D elevation.  You can see this by looking at 
your drawing from an oblique view. 
 
Select the ISO View SW icon button found on your left side screen menu. 
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You will see from this oblique view that the points are at their elevation 
towards the top of the screen and the annotation is at an elevation of zero.  

 
 
Now pick the Top View (Plan View) icon button found on your left side 
screen menu, to return to a normal view. 

 
 

 
Line Connection – Z-coding 

We are going to connect points sharing the same description with 3D break 
lines, so let’s create a layer on which to place them.  Select the green layers 
icon in the top left portion of the screen, as shown here. 
 

 
 
Make a new layer called "lines" and make it current as follows: 
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Type in LINES in the edit box and press the New button.  Highlight the 
LINES layer listing below and press the Current button.  Then pick the OK 
button to exit the dialog box. 
 
From the MicroSurvey pulldown menu, select AutoMAP System  Connect 
Points by X Y Z,  and you will see 
 

 
 
We will be using these as break lines for our topographic surface, so pick the 
3D Lines button.   
You will see some linework being drawn on screen and then you will see the 
following dialog box. 
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The data collector file in this example uses Z coding to allow for fast 
automatic connection of points with lines.  Normally, you would blank the 
description codes to remove the leading Z character, but for this demo, answer 
NO to blank description codes so you can see them. 
 
Now your screen should look like this.  The lines you see are in 3D, just like 
the points that were used to create the lines. 
 

 

 
Create Surfaces 

 
Now you have points and break lines, which is all you need for a topo map 
and surface. 
We will extract the data from which to make our map by using the Data 
Extraction filters in the Modeling routines.  This allows us to be very specific 
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on what we are using to create our surface.  You do not always need to use the 
filters but doing so allows you full control. 
 
Go to the Modeling pulldown menu and pick on Configuration Settings. 
This dialog will appear: 

 

 
 

Pick on the Data Extraction button and this dialog box comes up. 
 

 
 

Pick on the Filter by Entity button and then pick OK to continue, and OK 
again to exit the previous dialog. 
 
Next go to the Modeling pulldown menu and select Extract from Drawing 

 Extract to Surface.  You will see the dialog box shown here.  Accept the 
surface name of Ground and pick the OK button to continue.   
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Now you will be asked what it is you are picking to create your surface.  On 
this dialog pick POINT from the list – then pick the SELECT button and then 
the OK button to continue. 
 

 
 
Next select the points, by windowing the entire drawing, or simply press 
ENTER and the routine will grab everything in the drawing automatically for 
you.  Don’t worry if you get the break lines too as we have told it to filter out 
just the points at this time.   
 
264 points total in surface.  

 
You have now placed all the points on the surface Ground.  Now we need to 
do the same thing with the breaklines. 

 
Pull down the Modeling menu and select Extract from Drawing  Extract 
Breaks. This will show the following dialog box, similar to the one above.  
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Pick OK to accept the surface name Ground.  Both the points and breaklines 
must be on the same surface.   
 
Now you will see the following dialog box. 
 

 
 
Pick on the RESET button and then pick on LINE and POLYLINE, as 
shown below.  
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Then pick on the SELECT button.  What you are doing is telling the routine 
that you no longer wish to pick points but now wish to pick lines and polylines 
to add them as breaklines to your surface. 
Then pick on the OK button to continue. 
 
Now you can select the breaklines by making a window around the drawing, 
or by simply pressing ENTER to select everything on screen.  Don’t worry if 
you get the points too as the filter will only use the 3D lines and polylines it 
finds. 
 
179 additional points added to current surface.
 
Note: The order is important here.  Extract points first, then breaks.  This puts 
the extracted data into a surface named what you decide.  The default is 
GROUND.  We don’t see anything yet because we just created a surface in 
memory, but have not displayed it. 

 
 

3D Viewing and Advanced Rendering 
 
Most of the time you would just create and draw contours at this point, but we 
will take a two-minute side trip to explore basic site visualization in 3D. 
To start with, we are going to create and draw a TIN (Triangulated Irregular 
Network) representing the topography by selecting TIN from the Modeling 
menu, pressing return to select the <GROUND> surface and then answering 
D to Draw the surface (rather than the temporary Show) and press return twice 
to draw it as a polyface mesh entity with invisibility as NONE.  This is the 
3D surface representing the points and breaks of the surface. 
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Here is what you should now see. 

 

 
 
An interactive rendered view of this may be displayed by selecting Animated 
Rendering selection from the VIEW pulldown menu.  This will display the 
rendered surface in a window. 
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This display is interactive. Left-click and hold the mouse button down in the 
window and your cursor changes to a pointing hand.  Move the hand slowly 
(while holding the left mouse button down) and the image will rotate in 3D in 
real time.   
 

 
 
This feature is good for quick looks and can impress a client. 
 
Pick the X in the top right of the window to remove it from the screen. 
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Cleanup of screen 
 
We will erase the TIN from the screen so we can see the rest of the job.  We 
will use a shortcut to do this.  Press an E (for erase) followed by <enter>, then 
when prompted to select objects, answer L <enter> to select the last object 
drawn, then press <enter> again.  MicroSurvey has shortcuts called selection 
sets like Last and Previous that can speed your work. 
 
(If the Tin does not erase then try again and pick one of the triangles while in 
the erase command) 
 
Occasionally you may need to redraw the display in MicroSurvey to clean up 
artifacts from erasing entities.  
 
Pick one of these 3 buttons on the left side menu to run the redraw command. 
 

 
 

 
Quick Contours 

 
Contours may be generated by three different methods.  To set the correct 
method for what you require we need to do 2 things.  First we need to set the 
color map to what we require.  Go to the Modeling pulldown menu  Color 
Options  Reset Color Map. 
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Pick on the RESET button and then the OK button. 
What this is doing is setting the colors to standard CAD colors so you can set 
your pen widths for plotting easily. 
Now we need to tell the routine which method to use to color the contours and 
to set the interval. 
 
Go to the Modeling pulldown menu  Color Options  Contour Color 
Settings 
 

 

Set your defaults to 
match this dialog 

 
We will draw our contours on their own layer. Make a new layer named 
contours and make it current, just like you did for the lines layer previously.  
Select the Layer Management dialog and type in CONTOURS in the edit box 
and press New.  Highlight the CONTOURS layer and press the Current 
button.  Pick OK to close the dialog box. 
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Select the Contour command from the Modeling pulldown menu, press 
<enter> to accept the <GROUND> surface (the surface to which you 
extracted your points) and press <enter> to temporarily “show the contours". 
 

Getting Started in MicroSurvey CAD 2002  55 



 

 
 
The contours are NOT yet part of the drawing.  They are only in memory and 
displayed temporarily. 
 
The contours are displayed temporarily until the next refresh of the screen, 
such as pan or zoom or redraw.  If there was a problem with a bad elevation, 
you could fix it before drawing permanent contour lines. 
    

Setting up a Boundary 
 
Most of the time in a topo survey you will take shots outside of the actual 
property lines for control, but you may only want to display contours within 
the property outline.  We will do this by setting up and using a boundary.  A 
boundary acts like a Trim line, cropping the contours so they do not pass over 
the polyline.  We will add a boundary polyline, then draw and label contours 
for this site. 
 
Draw a polyline similar in shape to the bold line shown below to use as a 
boundary.  This line might represent a property line or an arbitrary trim line 
for the contours.  (Your polyline will not be bold by default.  We made this 
one bold so you could see it easily.) 
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If you are unfamiliar with the polyline command, type PL then left click on 
each location where you would like a vertex, then finish by typing a C to close 
the polyline into a closed polygon suitable for a boundary.  (See the 
MicroSurvey help for more information). 
 
Select this polyline as a boundary, by running the Boundary Options  Set 
Boundary command from the Modeling pulldown menu and selecting the 
polyline boundary you just created.  Press <enter> to complete the selection.  
Now the contours will be limited to within this boundary, when we run the 
contour command again to draw them. (See the help file for more on 
boundaries, including nested boundaries) 
 
Refresh the screen by picking on one of these 3 buttons on the left side menu. 
 

 
 
The contours disappear because they were displayed temporarily with the 
show command.   Now we will draw them permanently, honoring our new 
boundary. 
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Final Contours 
 
Select Contour from the Modeling pulldown menu, press <enter> to accept 
the <GROUND> surface (the surface to which you extracted your points) and 
pick DRAW from the Option Bar, and NO to the Close All prompt.  
 
You will now see the following on screen. 
 

 
 
The drawing is getting cluttered, so let’s turn off all layers except the 
Contours layer.  Go to the MicroSurvey pulldown menu  Layer Control 

 Isolate.  Then pick on one of the contours and press <enter>.   
 
What you are left with is this: 
 

 58  Getting Started in MicroSurvey CAD 2002 



 

 
 

Erase the polyline we drew for the boundary, as it is no longer needed, because 
the contours are now drawn and trimmed. 
 
Type E enter and pick the boundary polyline, then press enter. 
    

Labeling Contours and Saving Your Work 
 
Zoom in on the steep slope in the NW part of the site.  To zoom window, press 
Z <enter> W <enter> and specify two corners. 
The white box shows you where to pick for the Zoom Window command. 
 

Or, you can use the  button on the left side of the screen to zoom window. 
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Select Annotate  Label Contours from the Modeling pulldown menu.  
You will be prompted for a text height.  You may specify one graphically by 
clicking on the screen to indicate the text height,  or enter a number.  In this 
case a height of 2.5 was used. 
 
Next you will be repeatedly prompted for label locations.   
 
Click on contours where you would like labels, and the labels will be placed 
and the contours trimmed as needed. 
 

 
 
NOTE: To label many contours in a straight row, draw a polyline across the 
contours where you wish to have them labeled.  Then run the Label Contours 
command again – this time after giving the text height, pick the CONTROL 
button found on the option bar.  Then by following the prompts, select all the 
contours to label (be sure to not pick the polyline to be used as control lines to 
label along).  After picking all the contours to be labeled – press enter.  Then 
pick the control polyline and you should see the labels start to draw on the 
contour lines exactly where the control polyline intersected them.  The Control 
polyline is automatically removed from the drawing. 
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Example: 
 

 
 
Now lets Zoom to the Extents of the drawing to see everything on screen.   

Type Z <enter> then E <enter> or pick the .button. 
 
Now we are going to Smooth the contours.  Go to the Modeling pulldown 
menu  Annotate  Smooth Contours. 
 
Either pick the contours to smooth or simply press <enter> to select them all 
automatically. 
 
After smoothing your diagram should look like this. 
 

 
 
NOTE: Be sure to complete ALL Labeling before running the Smooth 
Contours command.  You cannot smooth the contours, because the labeling 
routine will not work as designed and may give you bad results. 
 
Now save your job by picking the save command on the file menu.  You also 
need to save the surface by going to the Modeling pulldown menu  
Surface Operations.  Pick the surface name on the left side of the dialog and 
then select the Write QSB button. 
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Set the folder to Jobs2000, the same location we started the job.  Do not place 
the file in the SOKKIA.MSJ folder.  Enter the name SOKKIA and press the 
SAVE button. 
 

 
 
Pick the OK button on the previous dialog to continue 
 
Your surface is now saved along with the drawing and the database.   
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You may now exit the program via the File pulldown menu. 
 
(End of tutorial) 
 
   



 

 64  Getting Started in MicroSurvey CAD 2002 

Simple Traverse Tutorial 
 
 
Because of the size and complexity of this tutorial we have broken it down 
into 9 smaller steps to make it easier for you to follow. 
 
Step 1)  Starting the Job 
 
Step 2)  Setting the Defaults 
 
Step 3)  Manual Traverse Entry 
 
Step 4)  Start Entering Shots 
 
Step 5)  List of Data to Enter 
 
Step 6)  Coordinating the Traverse 
 
Step 7)  Computing Closure 
 
Step 8)  Adjust Angles + Compass Balance 
 
Step 9)  Listing the Traverse 
 



 

Starting the Job 
 
In this cookbook-style tutorial we will enter a simple 2D traverse around a 
farm. This traverse was done to locate the corners of the boundary, and to 
locate a building on the farm.  
 
Here is what your finished product will look like. 
 

 
 
Overview: 
The surveyor began by setting up on one corner of the farm property and 
assigning a coordinate of North = 1000, East = 1000, Elev = 0, Point number = 
1. He then backsighted an iron bar with a known direction of 214 degrees 12 
minutes, 15 seconds. Since he could not directly set up on all the bars on the 
property because of rocks, hedges, and fences, he traversed around the 
property taking side shots into the corners. On the traverse, he also located 
three corners of a shed. 
 
To Begin: 
Start a new drawing by going to the MicroSurvey Project Manager (found 
under the FILE pulldown menu) and picking the NEW button. 
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Then fill in the name of the job and call it FARM-A.  Then pick Open to 
continue. 
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Setting the Defaults 
 
Once the new job opens you will be asked to fill out the following as shown, 
setting the units to Feet, Azimuths and the scale to 1=500’.  Do not pick the 
OK button yet! 
 

 
 
Main Job Defaults dialog box 
 
From the bottom of this dialog box, select the Toggles button. Set the System 
Toggles as shown in the 3 Figures below. 
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System Toggles dialog boxes 
 
Now press the OK button to return to the previous dialog – and press the OK 
button again to continue. 
   

Manual Traverse Entry 
 
This is what your screen should now look like: (if the Assistant is not on 
screen then pick the Assistant button from the Option Bar near the top left of 
the screen. 
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Next, from the Assistant, pick the Traverse Entry / Edit / Adjustment 
button: 
 

 
 
Pick the Enter Traverse Field Notes button.  
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Pick on the New Traverse button 
 
MicroSurvey will respond with a dialog box for you to enter your job name. 
Enter FARM-A in the dialog box as shown below: 
 

 
 
Pick the SAVE button to continue.  You will be prompted with a dialog box to 
fill out with information about the traverse: 
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Pick OK and then you will be asked: 
 

 
 
Answer this NO, as we will use the normal dialog boxes to enter the traverse.   
 
Answer Yes to the following dialog, so we start entering data with dialog 
boxes: 
 

 
 
We will work with the dialog boxes so answer YES to this. 
 
Now you are asked to enter the information for your first setup station, with 
appropriate backsight information. 
We have a Setup Point of 1 with coordinates of N=1000, E=1000, Z=0 so 
enter the Setup Point Number as 1 and then pick the EDIT button to the right 
of the point number.  Fill in the new Dialog as shown below and pick Ok to 
finish. NOTE: Use the TAB key to move between fields: 
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We have a backsight azimuth of 214 degrees 12 minutes 50 seconds from 
where we set up, so a backsight azimuth of 214.1250 in the edit box, as shown 
below: (Leave the other entries as shown) 
 

 
 
Now pick the OK button to continue. 
 
The program will go immediately into the data entry mode.  
 
   

Start Entering Shots 
 
Enter the first shot information into the dialog box as shown below. 
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(If the above dialog asks for Vertical Angles and Slope Distances instead of 
the Horizontal Distance and Vertical Distance, then you did not set the system 
toggles correctly.  Exit out of the Traverse Entry Mode, change the Toggles to 
match what was given earlier and start the traverse entry over again) 
Pick the OK button or press <enter> to continue 
 
The program will compute the coordinate and display the information in a 
dialog box: 
 

 
 
Pick OK to accept this information.  
 
MicroSurvey allows you to switch back and forth between entering traverse 
legs and entering side shots at any time. We will enter the traverse and side 
shots together. 
 
Rather than fill up this entire manual with screen shots showing the 
information to type into this tutorial, we are going to list the shots and setup 
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information to enter.  (To start a new setup, just pick Next Setup or press Esc 
at the Enter Correct Data For Shot dialog box.  The program will return to 
the setup dialog box.) 
 
At this point you will be asked for the next side shot to be entered from the 
same setup.  We have no more shots from this setup so we need to traverse 
forward to the last shot we just finished entering. 
Pick the Next Setup button or press the Esc key on your keyboard to return to 
the Enter the Setup Information dialog box. 
 

 
 
   

List of Data to Enter 
 
You will notice it has automatically updated the setup point number and the 
backsight point number with the following data: 
 
Set up on Point 7 and backsight 1. 
Pick the OK button to accept these values. 
 
Now you can enter the next Shot 
 
Horizontal Angle :131.0316 
Horizontal Distance :248.31 
Vertical Distance :0 
Point Number :8 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
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Next pick the Next Setup button to go back to the setup dialog box. 
 
Set up on Point 8 and backsight 7. 
Pick the OK button to accept these values. 
 
Enter the following Shot: 
 
Horizontal Angle :134.2554 
Horizontal Distance :83.92 
Vertical Distance :0 
Point Number :2 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :231.5652 
Horizontal Distance :302.5 
Vertical Distance : 0 
Point Number :9 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Next pick the Next Setup button to go back to the setup dialog box. 
 
Setup on Point 9 and backsight 8. 
Pick the OK button to accept these values. 
 
Enter the following Shot: 
 
Horizontal Angle :237.1721 
Horizontal Distance :341.71 
Vertical Distance : 0 
Point Number :10 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Next pick the Next Setup button to go back to the setup dialog box. 
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Setup on Point 10 and backsight 9. 
Pick the OK button to accept these values. 
 
Enter the following Shot: 
 
Horizontal Angle :203.2344 
Horizontal Distance :60.18 
Vertical Distance : 0 
Point Number :3 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :86.3210 
Horizontal Distance :312.35 
Vertical Distance : 0 
Point Number :15 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Next pick the Next Setup button to go back to the setup dialog box. 
 
Setup on Point 15 and backsight 10. 
Pick the OK button to accept these values. 
 
Enter the following shot: 
 
Horizontal Angle :123.1746 
Horizontal Distance :40.19 
Vertical Distance : 0 
Point Number : 4 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
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Horizontal Angle :317.1045 
Horizontal Distance :56.92 
Vertical Distance : 0 
Point Number :12 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :300.1321 
Horizontal Distance :38.54 
Vertical Distance : 0 
Point Number :13 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :287.3017 
Horizontal Distance :51.68 
Vertical Distance : 0 
Point Number :14 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :258.1506 
Horizontal Distance :658.78 
Vertical Distance : 0 
Point Number :16 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
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Next pick the Next Setup button to go back to the setup dialog box. 
 
Set up on Point 16 and backsight 15. 
Pick the OK button to accept these values. 
 
Enter the following Shot: 
 
Horizontal Angle :131.4731 
Horizontal Distance :69.42 
Vertical Distance : 0 
Point Number :5 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Point Number : 6 
Horizontal Angle :264.1350 
Horizontal Distance :695.37 
Vertical Distance : 0 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
 
Next pick the Next Setup button to go back to the setup dialog box. 
 
Setup on Point 6 and backsight 16, and   
Pick the OK button to accept these values. 
 
Enter the following Shot that is back to the original setup point: 
 
Horizontal Angle :273.5655 
Horizontal Distance :1399.37 
Vertical Distance : 0 
Point Number :21 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
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Next pick the Next Setup button to go back to the setup dialog box. 
 
Setup on Point 21 and backsight 6. 
Pick the OK button to accept these values. 
 
Now take the final shot to the closing foresight point. This is the starting 
backsight point. 
 
Horizontal Angle :139.3500 
Horizontal Distance :100 
Vertical Distance : 0 
Point Number :31 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
 
Next pick the Next Setup button to go back to the setup dialog box. 
 
This concludes the survey data entry. You can exit by picking the CANCEL 
button. 
 
   

Coordinating the Traverse 
 
You should be back to the assistant menu shown below: 
 



 

 
 
We are going to Edit your Traverse Data to ensure you have not made any 
mistakes in entry 
 
Pick on the Edit Traverse Data button. 
 
You will see the following Summary: 
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Close the Assistant dialog that appeared on top of the window. 
 
Scroll down using the bar on the right to see the rest of the listing as shown 
below: 
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(If you do have errors then you can edit the entry and make the correction 
now.) 
 
(If you do have errors then you can edit the entry and make the correction 
now.) 
 
Select Re-coordinate Traverse from the Edit Menu on the Active Drawing 
Editor.  Or you can type Ctrl-R if the editor window is current. 
 
You will be given the option of creating a Re-coordination Report or Log.  
Accept the defaults as shown: 
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After the traverse has been coordinated you will be returned to the Assistant.  
Pick the EXIT button to leave the Assistant. 
 
Next go to the Option Bar and pick on the button marked ViewLOG. 
 
You will see the following Window appear. 
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You may print this report now by going to the File pulldown menu on this 
window, and pick the Print command. 
 
Pick the X in the top right of the window to close it. 

Pick the Zoom Extents Button on the right of the screen,  
 
Now your screen should look like this: 
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Save the project by entering the SAVE command.    

Computing Closure 
Now we will compute the closure error.  Select the ASSISTANT from the 
option bar, then pick the Traverse Entry /Edit/ Adjustment button.  Then 
pick the Compute Traverse Closure button.  You will be asked: 
 

 
 
Pick the YES button to continue. 
 
Now you will be asked if you have a Closed Loop or Open traverse. 
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Select Open Traverse, because we have an external backsight and closing 
foresight on this traverse. 
 
MicroSurvey quickly analyzes the traverse and finds the last instrument setup 
point number. It offers this as the closing point number:  Our traverse matches 
the first of the 3 scenarios presented: 
 

 
 
Pick the OK button to continue. 
 
You will be shown the calculated coordinates of point 21: 

 
 
You must change these to reflect the true coordinates of point 21.   
To make this easy for you pick on the button marked Copy. 
 
This brings up another dialog that allows you to enter in the point number that 
has the correct coordinates for point 21. 
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21 is the same point as 1 so enter point number 1 and Pick OK to return to the 
previous dialog. 
 
It will now look like this: 
 

 
 
Pick the OK button to continue. 
 
Enter Closing Foresight Point 31, as shown below: 
 

 
 
Pick the OK button to continue. 
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You are asked for the actual coordinates of point 31.  The numbers shown are 
the calculated values.  Enter in the following KNOWN values, as shown: 
 

 

Pick the OK button to continue and 
the Traverse Closure Report will be 
generated on the Command 
Window.  
 
Then pick the EXIT button on the 
Assistant. 

 
Pick the ViewLOG button from the Option Bar and then scroll down using the 
slide bar on the right, until you see the following.  (Remember you can print 
this by going to the File pulldown menu on the Log Window and run the Print 
command.) 
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Pick the X in the top right corner of the window to close it. 
 
    

Adjust Angles + Compass Balance 
 
We are now going to do an Angular Balance on this traverse.  Go to the 
MicroSurvey Pulldown menu  Traverse Coordinating and Balancing 
and pick on the Angle Balance option. 
Answer YES to the following: 
 
Point protection is on. Do you want it turned off?
(Y/N)
 
The angles on this traverse will be balanced. The closure will be recomputed 
and displayed. Pick on the ViewLOG button again and scroll down to the 
bottom to see the results shown here. 
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Pick the X in the top right corner of the window to close it. 
 
Next you can perform a compass balance by going to the MicroSurvey 
pulldown menu  Traverse Coordinating and Balancing and pick on the 
Compass Method Adjustment option. 
 
The traverse will be balanced according to the Compass Rule. The coordinates 
for the main traverse and any side shots will be adjusted. 
 
Now Pick on the ViewLOG button again and scroll down to the bottom to see 
the results shown here. 
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Pick the X in the top right corner of the window to close it. 
  
Now lets see the traverse on the screen. to the MicroSurvey pulldown menu 

 Traverse Coordinating and Balancing and pick on the Show Traverse 
Graphically option. 
 

 
 
Answer NO if you wish to see the linework temporarily until a redraw 
command cleans up the screen.  Answer YES if you wish to draw every line 
into the drawing permanently.  (With the toggles and labeling defaults 
controlling their appearance)  I Entered NO and this is what I get: 
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Listing the Traverse 
 
Finally, we will dump a listing of the traverse to the Log file.  Go to the 
MicroSurvey pulldown menu  Traverse Coordinating and Balancing 
and pick on the List Traverse File option. 
There are two formats of the listing: long and short. 
 

 
 
Pick YES for the Short Listing. 
 
Now Pick on the ViewLOG button again and scroll down to the bottom to see 
the results shown here. 
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Keep scrolling to see the entire listing. 
 
(Remember you can print this by going to the File pulldown menu and picking 
on the Print command.) Pick the X in the top right corner of the window to 
close it. 
 
You may also create a separate report rather than appending it to the 
ViewLOG, by going to the MicroSurvey pulldown menu  
Print/Edit/View Reports and picking on the Traverse Listing option.    
 
Change the default folder to JOBS2000 and give it a report name as shown: 
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Pick the SAVE button to continue. 
Next choose from the 2 formats available. 
 

 
 
Answer NO this time to see the following Long Format: 
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It is MUCH longer than the short listing so be sure to scroll down to view it 
all.  If you decide to print the long format then make sure you have lots of 
paper available. 
 
The new Active Drawing Technology Editor offers formatted listings of much 
higher quality than ever available.  Following is a print preview from the File 
menu of the Editor: 
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 (End of tutorial) 

 

 

 96  Getting Started in MicroSurvey CAD 2002 



 

Getting Started in MicroSurvey CAD 2002  97 

Property Line Tutorial 
 

Because of the size and complexity of this tutorial we have broken it down 
into 14 smaller steps to make it easier for you to follow. 
 
Step 1) Starting the Job 
 
Step 2) COGO Calcs (Property Boundaries) 
 
Step 3) Distance/Distance Intersection 
 
Step 4) 3 Point Curve 
 
Step 5) More COGO 
 
Step 6) Bearing/Distance Intersection 
 
Step 7) And More COGO 
 
Step 8) COGO One More Time 
 
Step 9) More 3 Point Curves 
 
Step 10) Setting the Toggles 
 
Step 11) Locating the Buildings (Using OFFSETS) 
 
Step 12) Work on the SHED 
 
Step 13) Line Inverse 
 
Step 14) Job Complete 
 



 

Starting the Job 
 
In this tutorial, we will be using COGO Only, to calculate a drawing of three 
adjacent properties with a house and shed on the center property. During this 
tutorial, we will record our entry into the new Active Batch Cogo System.  
The figure below illustrates some of the field notes taken by a survey party to 
give you a feeling for what you are entering.  
 

 
Property field notes 

 
From the Project Manager, make sure you are working in the Jobs2000 folder. 
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Then pick on the NEW button to start a new job.  Set the new job name to 
COGO. 
 

 
 
Pick the OPEN button to continue. 
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Set the MicroSurvey General 
Configuration Options to 
Metric, Bearings with a scale 
factor of 1:250. This scale is 
chosen so the bearings and 
distances will be clear in 
MicroSurvey.  

 
 
Using the same procedure as the Traverse tutorial, set up the MicroSurvey 
system toggles as shown. 
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If the Assistant appears on screen, pick the EXIT button to remove it. 

 
COGO Calcs (Property Boundaries) 

 
 
Before we start performing COGO calculations, turn on the Batch COGO 
recording control by typing: MS_BATCH or select it from the MicroSurvey 

 Points / Lines / Curves  Active Batch COGO   Load Control Dialog.  
The following dialog should appear 
 

 
 
Pick the Set button and choose New: 
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You will be prompted to enter a batch file name. Enter "Property Line 
Tutorial" and press Save. 
 

 

Note: We have 
included this batch file 
for your use as a later 
comparison, or if you 
want cheat, you can 
just load the batch file 
and run it. Do not do 
this if you really want 
to learn how to use our 
COGO. 

 
Now, Pick the Start button, and the dialog should show Recording ON. 
 
To begin calculating the property boundaries, Pick the COGO button from the 
Option Bar, or type COGO at the MicroSurvey command prompt. Respond as 
shown to these prompts: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point <1>: 1  <Enter> 
 
That coordinate is not in the file. Please enter it
now.
 
Fill out the dialog as shown (be sure to use the mouse or the TAB key to move 
between fields in the dialog) 
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Pick the OK button to continue. 
 
Because point #1 did not exist, MicroSurvey automatically asked you to define 
its location. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <1>  <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>:155.3030  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 30  <Enter> 
 
Enter the Solve Point: <2>: 2  <Enter> 
 
Enter Description:<>: BAR   <Enter> 
 
1 N55°30'30"E 30.000 1016.989 2024.726 2
 
Pick the side you want the bearing placed/Above/Below: A  <Enter> 
 
The bearing you just entered can be read as: First Quadrant (1), Fifty-five 
degrees, Thirty minutes, Thirty seconds, or N 55° 30’30" E. 
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Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <2> (At this point pick the 
Zoom Extents button on the left side menu so we can see the info already 
entered) ('ZOOMFIT will appear on the command line) 
 
(Recording) Enter From Point: <2>  <Enter> 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: 2..1-120   <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 32    <Enter> 
 
Enter the Solve Point: <3>:  <Enter> 
Enter Description:<BAR>: POST   <Enter> 
 
2 S64°29'30"E 32.000 1003.208 2053.607 3
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
By replying to ENTER BEARING with "2..1-120", you told MicroSurvey to 
take the bearing from point 2 to point 1 and turn a counterclockwise angle of 
120 degrees. Now let's continue… 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <3> <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: 2..3+90 <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 40    <Enter> 
 
Enter the Solve Point: <4>:  <Enter> 
 
Enter Description:<POST>: <Enter> 
 
3 S25°30'30"W 40.000 967.107 2036.381 4
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <4> ZE   <Enter>  (ZE is Zoom 
Extents)  
 



 

At this point the screen should look like this: 
 

 
 
Rather than continuing from point 4, we are going to jump back to point 1 and 
started a new calculation: 
 
(Recording) Enter From Point: <4>1   <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: 1..2+92  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 37.5   <Enter> 
 
Enter the Solve Point: <5>:  <Enter> 

Enter Description:<BAR>: <Enter>
 
1 S32°29'30"E 37.500 968.370 2020.144 5
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
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Distance/Distance Intersection 
 
Next is a DISTANCE - DISTANCE calculation so we can establish the center 
point of the curve at the front of the property. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <5> 4   <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 22   <Enter> 
 
Enter the Solve Point: <6>:  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>: 22   <Enter> 
 
Enter the To Point: <5> <Enter> 
 
Point :6 North : 947.363 East : 2026.678
 
Do you want to use this solution (Y/N) (N for other
solution) Y  <Enter> 
 
4 S26°10'16"W 22.000 947.363 2026.678 6
 
Enter Description:<BAR>: C <Enter> 
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
6 N17°16'38"W 22.000 968.370 2020.144 5
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
Point :6 North : 947.363 East : 2026.678
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <6>  ZE   <Enter> (ZE is Zoom 
Extents)  
 
Note that no special commands were required to do the DISTANCE - 
DISTANCE calculation; MicroSurvey knew to do this when you replied to a 



 

bearing prompt with the <enter> key. This logic is followed for all 
intersection calculations. Since this calculation yields two possible solutions, 
you were offered the opportunity to use the "other" solution. Generally 
MicroSurvey works in a clockwise manner, so the first solution offered is 
usually the clockwise solution. 
    

3 Point Curve 
Now we do a 3 point inverse to draw the curve and get the curve information: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <6>5..6..4   <Enter> 
 

 
 
Arc: 16.68 Chord: 16.29 Tangent: 8.77
Delta: 43.2655 Radius: 22.00
 
By entering three numbers as shown above, you told MicroSurvey to compute 
an angle clockwise from point 5 to point 4 with point 6 as the center of 
curvature. 
 
You should see this now: 
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More COGO 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <6> 1   <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: 2..1   <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 2..1 <Enter> 
 
Enter the Solve Point: <7>:13   <Enter> 
Enter Description:<C>: (space) <Enter> 
 
1 S55°30'30"W 30.000 983.011 1975.274 13
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
Entering the distance as "2..1" tells MicroSurvey to use the distance from point 
2 to point 1, or 30 meters in this case. 
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Bearing/Distance Intersection 

 
Next we want to do a BEARING - DISTANCE calculation from point 13 and 
point 6. Again, we will get two possible solutions and this time the "other" 
solution will be the one we want. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <13> ZE  <Enter> (ZE is Zoom 
Extents) 
 
At this point your drawing should look like this: 
 

 
 
(Recording) Enter From Point: <13>  <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: 13..1+70   <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: <Enter> 
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Enter the Solve Point: <14>:  <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing #2 like QDD.MMSS: <>: <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>: 22   <Enter> 
 
Enter the To Point: <14>  6   <Enter> 
 
Point :14 North : 933.912 East : 2044.087
Do you want to use this solution (Y/N) (N for other solution) N   <Enter> 
 
Point :14 North : 959.450 East : 2008.296
Do you want to use this solution (Y/N) (N for other solution) Y  <Enter> 
 
13 N56°40'24"W 22.000 959.450 2008.296 14
 
Enter Description:< >: POST   <Enter> 
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
14 S56°40'24"E 22.000 947.363 2026.678 6
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 

 
Do a redraw to ensure the screen looks clean by picking 
one of these 3 buttons on the left side menu. 

   
And More COGO 

 
Now we calculate point 19: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <14>  3   <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: 2..3  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 2.35   <Enter> 
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Enter the Solve Point: <7>:19 <Enter> 
 
Enter Description:<POST>: (space) <Enter> 
 
3 S64°29'30"E 2.350 1002.196 2055.728 19
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
Since we did not want any description for this point, we used the spacebar to 
blank the default that was offered. Now we calculate Point 20: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <19> <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: 229.2930   <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 1..2   <Enter> 
 
Enter the Solve Point: <7>: 20  <Enter> 
 
Enter Description:<BAR>: (space) <Enter> 
 
19 S29°29'30"E 30.000 976.083 2070.497 20
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
Now we will calculate Point 21 using a Distance-Distance Intersection. Take 
the second distance from the points on the drawing by entering a two point 
inverse: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <20> <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 33.2   <Enter> 
 
Enter the Solve Point: <21>:  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 



 

Enter Distance2: <>:  4..6   <Enter> 
 
Enter the To Point: <21>   6  <Enter> 
 
Point :21 North : 951.388 East : 2048.307
Do you want to use this solution (Y/N) (N for other solution)  Y <Enter> 
 
20 S41°56'32"W 33.200 951.388 2048.307 21
 
Enter Description:< >: BAR   <Enter> 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
21 S79°27'21"W 22.000 947.363 2026.678 6
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
Point :21 North : 951.388 East : 2048.307
  

More 3 Point Curves 
 
Next we do a 3 point inverse to draw the curve between points 4 and 21 and 
get the curve information: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <21>  4..6..21   <Enter> 
 

 
 
Arc: 20.46 Chord: 19.73 Tangent: 11.04
Delta: 53.1705 Radius: 22.00
 
And the last curve can be calculated between points 14 and 5. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <21> 14..6..5 <Enter> 
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Arc: 15.13 Chord: 14.83 Tangent: 7.88
Delta: 39.2345 Radius: 22.00
 

Setting the Toggles 
 
At this point your job should look like this: 
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Now we will use the Hot Toggles dialog to change the toggles so that 
MicroSurvey will not draw bearings and distances on the sides of the house 
and shed. 
 
Click on the Draw Bearings toggle. 
Click on the Draw Distances toggle. 
 
The Hot Toggles 
dialog should now 
look like this: 

 
 
 
 

Locating the Buildings (Using OFFSETS) 
 
Now we will locate the house and shed on the center property. The figure 
below shows these structures in expanded detail as defined by the field notes. 
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We begin locating the structures with a BEARING - BEARING intersection 
with OFFSETS. The bearings are taken from the lines by doing two point 
inverses. The offset distances are entered by using a % sign. Long ago one of 
our customers said they always write their field notes with o/s to signify 
offsets so they recommend we use the % sign. It works… 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <21> 5   <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>:  5..1%8.5  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: <Enter> 
 

Getting Started in MicroSurvey CAD 2002  115 



 

 116  Getting Started in MicroSurvey CAD 2002 

Enter the Solve Point: <7>:  <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing #2 like QDD.MMSS:<>:5..4%-16.49 
<enter> 
 
Enter the To Point: <6>  5 <Enter> 
 
Enter Description:<C>  (space) <Enter> 
 
5 N01°39'31"W 16.584 984.947 2019.664 7
7 S01°39'31"E 16.584 968.370 2020.144 5
 
To review: the % sign used in the bearings tells MicroSurvey that you are 
entering information on an offset. Positive is to the right and negative is to the 
left of the reference line.  
 
Next is a BEARING - DISTANCE intersection with an OFFSET. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <7>  5  <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>:  5..1%9.1 <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:  <Enter> 
 
Enter the Solve Point: <8>:  <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing #2 like QDD. SS: <>: <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>: 3   <Enter> 
 
Enter the To Point: <6>  7   <Enter> 
 
Point :8 North : 987.749 East : 2018.591
 
Do you want to use this solution (Y/N) (N for other solution)  Y <Enter> 
 
5 N20°57'17"W 3.000 987.749 2018.591 8
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Enter Description:<C>: (space) <Enter> 
 
8 S20°57'17"E 3.000 984.947 2019.664 7
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <8> <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>:  8..7-90   <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 2   <Enter> 
 
Enter the Solve Point: <9>:   <Enter> 
Enter Description:< >:  <Enter> 
 
8 N69°02'43"E 2.000 988.464 2020.459 9
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <9> <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>:  9..8+90   <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 5   <Enter> 
 
Enter the Solve Point: <10>: <Enter> 
 
Enter Description:< >: <Enter> 
 
9 N20°57'17"W 5.000 993.133 2018.671 10
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <10> <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>:  10..9-90   <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 8   <Enter> 
 
Enter the Solve Point: <11>: <Enter> 
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Enter Description:< >: <Enter> 
 
10 N69°02'43"E 8.000 995.994 2026.142 11
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <11> <Enter>
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 8.1   <Enter> 
 
Enter the Solve Point: <12>: <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>:  10.2   <Enter> 
 
Enter the To Point: <12>  7   <Enter> 
 
Point :12 North : 988.504 East : 2029.224
 
Do you want to use this solution (Y/N) (N for other solution) Y <Enter> 
 
11 S22°21'59"E 8.100 988.504 2029.224 12
 
Enter Description:< >: <Enter> 
 
12 S69°35'36"W 10.200 984.947 2019.664 7
 
Point :12 North : 988.504 East : 2029.224
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Work on the SHED 
 
This completes the house; now we proceed to the shed. For the following 
DISTANCE - DISTANCE calculation, we will select the "other", or NEAR 
solution. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <12> 11   <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 4.5   <Enter> 
 
Enter the Solve Point: <15>:  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>:  17.5   <Enter> 
 
Enter the To Point: <12>  2   <Enter> 
 
Point :15 North : 999.541 East : 2023.372
 
Do you want to use this solution (Y/N) (N for other solution)  N  <Enter> 
 
Point :15 North : 999.881 East : 2028.410
 
Do you want to use this solution (Y/N) (N for other solution)  Y <Enter> 
 
11 N30°16'10"E 4.500 999.881 2028.410 15
 
Enter Description:< >: <Enter> 
 
15 N12°09'07"W 17.500 1016.989 2024.726 2
 
Point :15 North : 999.881 East : 2028.410
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <15>  2   <Enter> 
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Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 16.8   <Enter> 
 
Enter the Solve Point: <16>:   <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>:  2   <Enter> 
 
Enter the To Point: <3>  15   <Enter> 
 
Point :16 North : 1001.049 East : 2030.033
 
Do you want to use this solution (Y/N) (N for other solution)  Y <Enter> 

2 S18°24'55"E 16.800 1001.049 2030.033 16
 
Enter Description:<POST>: (space) <Enter> 
 
16 S54°15'40"W 2.000 999.881 2028.410 15
 
Point :16 North : 1001.049 East : 2030.033
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <16>  <Enter> 
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD.MMSS:<>: 16..15-90  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 2.5  <Enter> 
 
Enter the Solve Point: <17> :  <Enter> 
 
Enter Description:< >: <Enter> 
 
16 S35°44'20"E 2.500 999.020 2031.494 17
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <17> <Enter> 
 
Options: +/- or Pt..Pt+-Angle



 

Enter Quadrant Bearing like QDD.MMSS:<>: 17..16-90  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 15..16   <Enter> 
 
Enter the Solve Point: <18> :  <Enter> 
 
Enter Description:< >:   <Enter> 
 
17 S54°15'40"W 2.000 997.851 2029.870 18
 
We need to erase a few extra lines that are on the drawing, but at this point 
your drawing should look like this: 
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Line Inverse 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <18>  15..18   <Enter> 
 

 

You should see this 
information dialog. 
Press the Ok button: 

 
15 S35°44'20"E 2.500 997.851 2029.870 18
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt
(Recording) Enter From Point: <18> Esc 

 
Job Complete 

 
The shed is now complete. Finally, by deleting unneeded lines, we get the 
property drawing shown below.  
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Final property drawing 
 
Save your job by picking the SAVE command from the File pulldown menu. 
 
Now, Pick the Stop button on the Batch COGO Control window. It should 
show Recording OFF. 
 
Pick the Edit button and you should see something like this window.  It has 
been expanded so you can see more: 
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Pick the SP and you can edit the starting coordinates. 
 

 
 
Pick the Edit menu and you can see all the commands available for building a 
batch file: 
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Scroll to the Bottom of the Grid and Pick the Type Cell  it will change to a 
pull down combo box with all the record types listed: 
 

 
 
 
(End of tutorial) 
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Earthwork Volume Tutorial 
 
Because of the size and complexity of this tutorial we have broken it down 
into 14 smaller steps to make it easier for you to follow. 
 
Step 1) Starting the Job 
 
Step 2) Setting the Defaults and Toggles 
 
Step 3) Importing a Data Collector File 
 
Step 4) Creating the Traverse File 
 
Step 5) Processing and Editing the Traverse File 
 
Step 6) Coordinate the Traverse 
 
Step 7) Working with AutoMAP 
 
Step 8)  Start the First Surface 
 
Step 9) Make the First TIN 
 
Step 10) Start the Second Surface 
 
Step 11) Extract the Second Surface 
 
Step 12) Make the Second TIN 
 
Step 13) Calculate Volumes between the 2 Surfaces 
 
Step 14) Cross Sections across the Job 
 



 

Starting the Job 
From the Project Manager, make sure you are working in the Jobs2000 folder. 

 
 
Then pick on the NEW button to start a new job.  Set the new job name to 
VOLUMES 
 

 
 
Pick the OPEN button to continue. 
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Setting the Defaults and Toggles 
 
As soon as the job is open you are asked to check or set the General Defaults. 
 

 
 
Please take the time to make your General Defaults the same as shown here.  
Pick the OK button to continue. 
 
Now that your job is open, you have many options presented to you.  The first 
set of options are available from the MicroSurvey Assistant – Main Menu.  
This is a floating dialog box with commands on it that you can pick. 
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We will go and check and set the program defaults.  To do this pick the button 
Set Program Defaults.  Next you will be given another dialog box to choose 
from. 
 

 
 
In this dialog box we can choose to set any of the drawing defaults that we 
may need.  In this tutorial we are going to assume that everything we do not 
look at is considered okay for this job. 
 
We need to check our Toggles so pick the COGO Toggles button.  This will 
show you the following dialog boxes.  Please make yours look the same as 
ours shown here.  When done pick the OK button. 
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System Toggles dialog boxes 
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Pick the OK button to continue.  This will take you back again to the 
MicroSurvey Assistant – Defaults Menu.  Press the OK button to return to 
the MicroSurvey Assistant – Main Menu. 
 

 
Importing a Data Collector File 

 
From here we are going to go through the steps to read our data collector file 
from the hard drive into our program and save it into a traverse file. 
 
Pick on the button labeled Import ASCII File or Data Collector File.  You 
will see this next dialog box. 
 

 
 
We are going to import a data collector raw file so pick the button labeled 
Import Data Collector ASCII File.  This will bring up a dialog box with all 
the different collector types that we support. 
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As you can see, the list of supported collector files is very large and includes 
all the major brands on the market.  For this tutorial we will use a file collected 
in the Topcon format.  (This is not saying that Topcon is the collector of 
choice, only that the file used in this tutorial was of this format.  All of the 
other collector formats would give equally suitable data in this type of job.) 
 
Pick the button labeled Topcon FC4/On Board (bottom left corner of the 
dialog).  As soon as you do you will be presented with the following dialog 
box; 

 

 
 

This allows you to quickly check or change your toggles before proceeding.  
Pick the OK button to continue. 
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You will then be asked to give the file name of the collector file. Go to the 
\MSCAD2002\TUTORIAL directory and pick on the file Fc4-big2.raw. 
 

 
 
Once you have selected the correct file, press the OPEN button to continue. 
 

 
Creating the Traverse File 

 
You will then be presented with the dialog box asking if this is a New or 
Existing Traverse. 
 

 
 
This is a New Traverse so pick the New Traverse button.  Now you will be 
asked to name your traverse file.  This allows you to have several traverses in 
one job and keep them all organized so you can work on them separately. 
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You can name your traverse file anything that makes sense to you.  I have 
chosen the name VOLUMES for the traverse. The program will use the 
project name as the default. Once you have entered the name press the Save 
button. 
 
Next you will be asked to enter some information about this traverse.  You 
may leave this blank if you wish but a good practice is to fill in the 
information as it is used later in printouts. 
 

 
 
Then press the OK button to continue. 
 
From this point, the program very quickly reads the raw data file from the hard 
drive and stores it into our traverse file.  You will see the information scrolling 
very quickly at the top of the screen in the prompt area.  You should see 4  
points on the main screen. These were points entered as coordinates in the raw 
collector file.  The rest of the shots have been recorded as raw data and have 
not been coordinated. We will do that next... 

 
Processing and Editing the Traverse File 

 
You will see this dialog box in the middle of the screen. 
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Pick on YES so we can see the raw data in the traverse file and confirm that it 
is correct and complete. 
 

 
 

Coordinate the Traverse 
 
Select Re-coordinate Traverse from the Edit Menu on the Active 
Drawing Editor.  Or you can type Ctrl-R if the editor window is 
current. 
 
You will be given the option of creating a Recoordination Report or Log. 
Accept the defaults as shown: 
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Now you will see the coordinates being calculated in the prompt area on top of 
the screen as well as the information being drawn into the graphics window.  
The entire job will be imported and displayed on screen. 
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The linework you see is only temporary and will be erased as soon as you do a 
zoom command or a redraw command.  You will be left with nothing but the 
points at that time.  To be able to do a zoom or redraw command we have to 
exit out of the MicroSurvey Assistant menus.  Press the OK button and then 
the EXIT button to get out of the assistant.  Then do a Zoom Fit (zoom 
extents) by picking this button on the left of the screen.  
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You will now see the points as shown below. 
 

 
 

Working with AutoMAP 
 
Our objective is to calculate the volume of this pile of earth.  To do this we 
need to layer separate the data to help us build the two surfaces.  In other 
words we want all the points with descriptions of TOP to be on one layer and 
the points with descriptions of BOTTOM on a different layer.  This will make 
it easier to select the correct points to create surfaces to generate volumes. 
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To do this we are going to use the AutoMap program.  You can find this in the 
MicroSurvey pulldown menu as shown.  This command is available in other 
locations as well. 
 

 
 
This will display the dialog box below. 
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This is a powerful command but we will just use a portion of it’s power in this 
tutorial.  First thing you need to do is pick the New Library button.  This will 
remove the current listing of descriptions (which do not match our current job) 
and allow us to then pick the Scan Dbase button which will go to our job and 
look up every description we used and display them, ready for editing. 
 

 
 
This job has 3 different descriptions.  BOTTOM, TOP and NL.  We do not 
need the NL description as it only defined the control points and is not related 
to the surfaces we are creating, so we are going to delete this description from 
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our list.  This will not erase the points for the job.  It only means that the points 
will not be relocated to another layer or have linework connecting them, so do 
not worry.  Pick the description NL from the left side of the dialog and then 
pick the Delete button. 
 
You will be asked if you are sure that you wish to delete this description. 
 

 
 
Pick the YES button to continue. 
 
This will leave you with only the BOTTOM and TOP descriptions to be 
edited.  Now pick on the description BOTTOM and pick the Edit button.  You 
will now see this dialog box. 
 

 
 
This dialog box has many options on it.  The ones we are concerned with are 
in the bottom half.  Set your program to match the dialog below. We are not 
applying any symbols, but we are going to draw a 3D polyline connecting all 
the points with the description Bottom, in increasing point number order.  We 
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are also moving the nodes, elevations and point numbers to the same layer as 
the description and polyline. Note: Set the layer color to Red. 
 

 
 
When you have set all the options as above then press the OK button and edit 
the description TOP in the same method.  The settings are shown below. Note: 
Set the layer color to Blue. 
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Pick the OK button after setting the above dialog. 
 
Lets save this library for future use.  Pick on the Save Library button. 
 

 
 
Give the library a unique name of VOLUMES, as shown above.  Pick the 
SAVE button to continue. 
 
Now all that is left is to process the settings for the descriptions.  Press the 
Process AutoMAP Connections Now button.   
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Now you will see the following dialog box; 
 

  
 
Because we are not using the Z-Coding option in this example, simply pick on 
the Skip XYZ Method button to continue. 
 
Using the layer manager (green button near the top left side of the screen) we 
will freeze the layers shown below by picking on the layer names to highlight 
them. Hold down the Control Key on the keyboard to make a multiple 
selection. Pick the FRZ button to freeze the layers – lastly, pick the OK button 
to exit the command. 
 

 
 
Now your job should look like this. 
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The Bottom points have all been placed on the BOTTOM layer and connected 
by a 3D Polyline and the Top points have all been placed on the TOP layer and 
connected separately by another 3D Polyline.   
 

 
Start the First Surface 

Now we are ready to generate 2 surfaces to calculate volumes from.  The 
first surface will have all of the Top and Bottom points to define the upper 
surface of the pile.   

 
To do this we will load the palette from the Modeling pulldown menu by 
picking on the option Load Modeling Toolbox.  The following palette 
(toolbox) will appear on screen.  Move it to a convenient location on the right 
of the screen. 
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To extract points to a surface, pick this button.  
 
The following dialog box will appear.  Please fill it out as shown below and 
then pick the OK button to continue.  
 

 
 
After picking the OK button you will be asked to select all the points to be 
used in this surface.  We need all of the points on screen to form the top 
surface so simply press the ENTER button to select them all. 
 
It should report in the command prompt area; 
 
727 points total in surface.
 
We have now defined the surface by extracting the points, but we now also 
need the breaklines to add more detail and make the surface accurately reflect 
the surface edges of the pile. 

To extract the breaklines to the same surface, pick this button.  
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The following dialog box will appear.  Please fill it out as shown below and 
then pick the OK button to continue.  Note: remove the Clear before extract 
checkbox! 
 

 
 
After picking the OK button you will be asked to select all the breaklines to be 
used in this surface.  We need all of the linework on screen to help form the 
top surface so simply press the ENTER button to grab them all. You should 
see something like this on the text screen: 
 
2 Break Lines extracted
337 stacked points dropped,
Auto densification...
756 triangles built
1206 triangles built
1308 triangles built
1348 triangles built
1372 triangles built
1386 triangles built
1398 triangles built
321 additional points added to current surface
 

 
Make the First TIN 

Next we need to create a TIN for this surface. Pick this button.  from 
the palette. 
 
The TIN command will ask you several questions.  Answer them as follows; 
 
Surface name <TOP>: <Enter> 
 
None/Show/Draw/Redraw <Show>? <Enter> 
 
This will temporarily display the TIN so we can confirm that the TIN has been 
generated correctly.   
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A redraw or zoom command will remove the TIN from the screen. 
 

 
Start the Second Surface 

 
Now we need to create the Bottom surface.  It is difficult to pick the points 
around the outside edge of the pile without accidentally picking other points as 
well, so we will isolate the bottom layer on screen.  This command can be 
found on the MicroSurvey pulldown menu  Layer Control then pick the 
ISOLATE option. 
 

After the command load you will be asked to: 

Select item on layer to isolate: Pick on one of the red lines, 
then press <ENTER> 
 
Now the job should look like this: 
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Extract the Second Surface 

To extract the points to a new surface, pick this button.  
 
The following dialog box will appear.  Please fill it out as shown below and 
then pick the OK button to continue.  
 

 
 
After picking the OK button you will be asked to select all the points to be 
used in this surface.  We need all of the points on screen to form the bottom 
surface so simply press the ENTER button to grab them all. 
 
It should report in the command prompt area; 
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117 points total in surface.

So far we have the points that help define the surface but we now also need the 
breaklines. 

To extract the breaklines to the same surface, pick this button.  
The following dialog box will appear.  Please fill it out as shown below and 
then pick the OK button to continue.  NOTE: Remove the Clear before 
extract check box. 
 

 
 
After picking the OK button you will be asked to select all the breaklines to be 
used in this surface.  We need all of the linework on screen to help form the 
bottom surface so simply press the ENTER button to select them all. 

 
Make the Second TIN 

 

 
Next we need to create a TIN for this second surface. Pick this 
button. from the palette. 

 
The TIN command will ask you several questions.  Answer them as follows; 
Surface name <BOTTOM>: <Enter> 
 
None/Show/Draw/Redraw <Show>? <Enter> 
 
This will temporarily display the TIN so we can confirm that the TIN has been 
generated correctly.   
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A redraw or zoom command will remove the TIN from the screen. 

 
Calculate Volumes between the 2 Surfaces 

 
Now we can finally calculate the volume between the surfaces called TOP and 
BOTTOM. 
 
We can calculate the volume in two different ways.  First we will run the 
Surface Volume command from the Modeling pulldown menu  
Volumetrics. 
 
Fill out the two surface names as shown with the TOP surface on the left and 
the BOTTOM surface on the right.  Be sure to pick the check box beside 
Surface Name to be able to enter the BOTTOM surface 
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Now pick the OK button and volumes will be calculated and displayed in the 
command prompt area on screen.  Flip to the command prompt window by 
pressing the F2 function key (a second time to return to the normal screen) 
 
The volume will be displayed like this. 
 
Using conversion factor of 1.

Volume of TOP-BOTTOM based on a planar tin.
 
Positive Volume Negative Volume Net Volume
--------------- --------------- ----------

46522.834 -3.449e-005 46522.834 
 

The negative volume shown here is so small that it does not affect the job in 
any way and was due to minor deviations in the way the two TINs were 
generated.  Your final volume is  46,522.834 m3 (because our job was in 
metric – if it had been feet then the units would have been cubic feet by 
default) 
 
The Second way to calculate the volumes between the same two surfaces is the 
Area Volume command.   
 

 
Run the Area Volume command by picking this button  from the 
palette. 

 
Fill out the surfaces in exactly the same way as we did above for the Surface 
Volume command.  Pick OK to continue.   
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Now for the slight difference between the two methods.  You are now 
prompted… 
 
Select area polygons:
Return to select all visible or
Select objects: Pick the RED polyline around the bottom of 
the pile and press <enter>
 
(NOTE: When doing one of your real jobs instead of this tutorial – the 
polyline around the base may not be created properly with the AutoMAP 
command due to the order the points were picked up in, in the field.  You may 
find that you have to manually draw a polyline from point to point instead.) 
 
The polyline you pick now is the one that we drew with AutoMAP, around the 
base of the pile. 
 
The volume report will be the same – confirming that we have the correct 
answer. 
 
Using conversion factor of 1.

Volume of TOP-BOTTOM based on a planar tin.
 

Area Positive Volume Negative Volume Net Volume
---- --------------- --------------- ----------

46522.834 -3.449e-005 46522.834 
 
Area 1 will also be labeled on the drawing. 

 
Cross Sections across the Job 

 
For those who wish to confirm the volume by seeing cross sections to prove 
the answer, we have just the feature to do this. 
 
Under the Design pulldown menu AutoRoute options there is a command 
Across Full Surface. 
 



 

 
 
You will be asked which surface you wish to plot.  Select TOP and press OK. 
 

 
 
Next you will be asked which way do you wish to run the center line for all the 
cross sections to be related to.   Then you will be asked for the Interval for the 
cross sections. 
 
Begin on which side of surface
North/South/East/<West>: N  <Enter> 
 
Enter cross section interval: 20 
 
A center line and cross section lines will be drawn over the job as reference. 
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If you wish, you can erase these lines, or leave them for later reference.  Your 
choice!  
 

 
 
I left them on in my example by answering NO. 
 
Next you will be asked if you wish to plot the cross sections.  
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Answer Yes to this and you will get the following 
dialog box that controls the grid on the cross 
sections. 

 

 

Fill your dialog box out as shown 
above and when completed press 
the OK button.  Note: This job is a 
Metric job, so the width and height 
of the sheet are in mm. If you were 
working in feet, you would put in 
the inch size of the paper you were 
using, like 24 x 36 

 
. When you pick the Ok button, You will be prompted with: 
 
Pick lower left corner:  This is the insertion point for the cross 
sections so select a starting point over to the right of the diagram so they do 
not overlap each other. 
 
Below is one of the cross sections enlarged.   
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You can change the color of the layers to get better visual results or for setting 
pen widths for plotting.   

 
As a double check you can calculate the volume under the cross sections, to 
work out the volume the old hand method. 
 
Save your job by picking the SAVE command from the File pulldown menu.  
Then be sure to save your surfaces, as you were shown in the Data Collector 
Tutorial. 
 

(End of tutorial) 
 

Getting Started in MicroSurvey CAD 2002  157 



 

 158  Getting Started in MicroSurvey CAD 2002 

Road Design Tutorial 
 
Because of the size and complexity of this tutorial we have broken it down 
into 9 smaller steps to make it easier for you to follow. 
 
Step 1)  Opening the Job 
 
Step 2)  Create the Ground Surface 
 
Step 3)  Inputting the Horizontal Alignment 
 
Step 4) Stationing and Saving the Horizontal Alignment 
 
Step 5)  Create Profile 
 
Step 6)  Design New Profile 
 
Step 7) Create Cross Section Template 
 
Step 8) Create New Road Surface 
 
Step 9)  Output Cross Sections 
 

Opening the Job 
 
Start by opening the CONTOURS.FLX file from the Project Manager.  The 
CONTOURS.FLX file should reside in your \MSCAD2002\TUTORIAL 
directory by default. 
 



 

 
 
Pick on the job name and then pick the Open button. 
 
The system General Configuration Options should be set to match the 
following for this job to work cleanly.  Press the OK button once they are 
confirmed to be correctly set. 
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Exit out of the MicroSurvey Assistant if it comes up on screen.  We will not 
need this excellent tool for this tutorial. 
 
You will see a series of contours and a few points, they will be used to define 
your existing surface. 
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Create the Ground Surface 
 
Do the SAVEAS command to create a new drawing using the contours as a 
starting point.  This will protect the original data so you can execute the 
tutorial again if you wish. 
 
Type SAVEAS and press enter, or go to the File pulldown menu and pick on 
the SAVEAS command.. 
 

 
 
Change the default folder to save in \JOBS2000 and change the file name to 
CONT.FLX  then pick the SAVE button to continue. 
 
Next, we need to extract all of the 3D point data and 3D breaklines (contours) 
to create the existing surface. 
To do this we are going to control what is on screen by isolating the points and 
the breaklines on screen, one at a time.  Under the MicroSurvey pulldown 
menu -> Layer Control pick the ISOLATE option. 
Select item on layer to isolate: (pick on one of the points and press Enter) 
Now all you will see on screen are the points. 
 
Next we will load the Modeling palette from the Modeling pulldown menu 
by picking on the option Load Modeling Toolbox.  The following palette 
(toolbox) will appear on screen.  Move it to a convenient location on the right 
of the screen. 
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To extract points to a surface, pick this button.  
 
The following dialog box will appear.  Please fill it out as shown below and 
then pick the OK button to continue.  
 

 
 
After picking the OK button you will be asked to select all the points to be 
used in this surface.  We need all of the points on screen to form the top 
surface so simply press the ENTER button to grab them all. 
 
It should report in the command prompt area; 

21 points total in surface.
So far we have the points that help define the surface but we now also need the 
breaklines. 
 
Under the MicroSurvey pulldown menu -> Layer Control pick on the 
UNISOLATE option, this brings back the breakline layer.  Now Under the 
MicroSurvey pulldown menu -> Layer Control pick the ISOLATE option.   
 
Select item on layer to isolate: (pick on one of the breaklines (contours) and 
press Enter) Now all you will see on screen are the breaklines (contours). 
 

To extract the breaklines to the same surface, pick this button.  
The following dialog box will appear.  Please fill it out as shown below and 
then pick the OK button to continue.  
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After picking the OK button you will be asked to select all the breaklines to be 
used in this surface.  We need all of the linework on screen to help form the 
top surface so simply press the ENTER button to grab them all. 
 

Next we need to create a TIN for this surface. Pick this button.  from 
the palette. 
 
The TIN command will ask you several questions.  Answer them as follows; 
 
Surface name <GROUND>: <Enter> 
 
None/Show/Draw/Redraw <Show>? <Enter> 
 
This will temporarily display the TIN so we can confirm that the TIN has been 
generated correctly.   
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A redraw or zoom command will remove the TIN from the screen.  The Tin 
will remain in memory. 
 

Inputting the Horizontal Alignment 
 
Now that we have our surface we can create our alignment. 
 
Start by going to the Design pulldown menu -> AutoRoute and picking the 
Design Alignment command. 
 
In the Command prompt area, it will ask you the following, please enter the 
information shown: 

 
Enter alignment name: MAPLE 
 
* NOTE * 
When naming a horizontal alignment, be sure to use only a single word, with 
no spaces, as the name, such as: 
ROAD1, Orange_Side_Road, Maple_Street, Pine-Street, Maple 
 
From point: -200,100 
To point: 1,90 
To point: 70,-45 
To point: 240,-50 
To point:  <Enter> 
 
Note: It is not necessary to enter exact coordinate to create an alignment. You 
can also "pick" the points on screen. 
 
The center line of the road is now drawn. 
 



 

 
 
Next you will be asked if you wish to edit the alignment: 
 

 
 
Answer Yes so we can insert new curves and spirals. 
 
Edit alignment. Add/Delete/Move/Curve/SCS:  SCS 
 
Pick POT:   <pick the red circle at the FIRST bend in the road> (zoom 
in if you can not pick it easily.  Don’t miss it!) 
 
Now you will see the following dialog box. 
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Fill in the top left corner of the dialog, as shown above, and then pick the 
Calculate Spiral Variables button to calculate the rest of the fields in the 
dialog box.  Pick the OK button to place the spirals and curve on the screen. 
 
Pick POT: <Enter> 
 
Edit alignment. Add/Delete/Move/Curve/SCS: Curve 
 
Pick POT: <pick the red circle at the SECOND bend in the road> (zoom 
in if you can not pick it easily.  Don’t miss it!) 
 
Enter curve radius: 50 
 
Pick POT:   <Enter> 
 
Edit alignment. Add/Delete/Move/Editcurve/Newcurve:  
<Enter> 
 
Now you will be asked if you wish to continue and profile the existing ground 
surface? 
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Pick NO for now. 
 
At this point your job should look like this: 
 

 
 

 
Stationing and Saving the Horizontal Alignment  

 
Before we continue with the profile lets label the stationing along the 
alignment. 
Go to the Design pulldown menu -> AutoRoute pick on the  Label 
Alignment option 
 
Label alignment. Stations/Offsets/NewPoint/ExistingPoints/Report:   
 
STATIONS 
There are many options to label and create points along the alignment and on 
offsets, as well as reports. 
 
We are going to simply label points along the centerline in this example. 
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Pick OK to continue 
 
After picking Stations as the method you will have the following dialog box 
appear: 
 

 
 
Fill in the table as shown and pick OK to continue. 
 
Label alignment.
Stations/Offsets/NewPoint/ExistingPoints/Report:
<Enter> to continue
 
 
Here is what you will see on screen, 
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and a close up showing the labeling, 
 

 
 
You can see that the tangent, curve and spiral have had the stationing labeled, 
as well as the beginning of Curve and Spiral.  New points have been created 
along the centerline with the description set as the station.  Some text overlap 
is apparent and a simple move command can clean this up.   
 
Now we should save this alignment to a file to protect us and allow us to 
retrieve it without having to recreate it from scratch. 
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Under the Design pulldown menu -> AutoRoute pick on the Write .HRZ 
File option. 
 
On the command prompt window you will see the message that tells you 
where and what the file is called. 
 
Alignment saved in C:\Jobs2000\MAPLE.HRZ.
 

Create Profile 
 
Now that we are finished labeling and saving the horizontal alignment – lets 
continue with the vertical profile. 
 
Go to the Design pulldown menu -> AutoRoute and pick the Extract 
Existing Ground Profile option. 
 
You will be asked to pick from a list of surfaces – we want GROUND as our 
surface. 
 

 
 
Pick on the word GROUND and pick the OK button. 
 
Next you will be shown a dialog box that will control how the profile will be 
drawn. 
 
Change the settings to match this dialog: 
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The only value you need to change is the Grid Interval Horizontal from 100 to 
10.  Press the OK button to continue. 
Next you will be asked: 
 

 
 
Pick YES to continue 
 
Pick lower starting corner of grid:  <Pick Somewhere Appropriate – maybe 
Above the Alignment> 
 
You will be asked if you wish to create the design profile? 
 

 
 
Answer NO for now. 
 
Now lets set the Profile_Grid layer to gray (color 9) for easier visibility,   Go 
to the Green Layer button and pick on it. 
Then pick on the layer, as shown, and change the color to gray(9). 
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Pick OK to continue. 
 
Now the profile will look like this: 
 

 
 

Design New Profile 
 
Now that we have had a chance to look over our existing profile, we now need 
to create a design alignment. 
 
Go to the Design pulldown menu -> AutoRoute and pick on the Design 
Vertical Alignment option. 
Draw new profile grid or use existing New/<Existing>: <Enter> 
 
Enter vertical alignment name:   <MAPLE>  
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* NOTE * 
When naming a Vertical alignment, be sure to use only a single word, with no 
spaces, as the name, such as: 
ROAD1, Orange_Side_Road, Maple_Street, Pine-Street, Maple 
 
At this point, the program will draw a rubber band line from the bottom left 
corner of the graph.  This helps you to find the starting end of the profile. Pick 
on the graph where you wish to start the new profile line. 
 
Pick first VPI location:  < pick near the left edge around the 
existing profile> 
 
Change the dialog box that comes up, so the station and elevation look like the 
following; 
 

 
 
Pick the OK button. 
Next pick somewhere around the middle of the profile and change the dialog 
box so the station and elevation match the following; 
 

 
 
Pick the OK button. 
and lastly pick over near the top right and change the settings so the station 
and elevation match the following. 
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Pick the OK button. 
Press ENTER to continue. 
 
Next you will be asked: 
 

 
 
Pick YES to continue. 
 
Now you will be prompted, 
Add/Curve/Delete/Move: CURVE 

 
Select VPI:  <Pick the Red Circle at the FIRST bend in the vertical 
alignment> (zoom in if you need to, to be able to pick the red circle cleanly – 
don’t miss it) 
 
Enter or pick curve length: 150 <Enter> 
 
Select VPI: <ENTER> 
 
Add/Curve/Delete/Move:  <ENTER> 
 
Next you will be asked if you wish to pass our cross section template along the 
design alignment and create a new surface.   
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Answer NO for now because we need to create the template first. 
 
Before we do the Cross Section Template, lets label the vertical curve. 
Go to the Design pulldown menu -> AutoRoute and pick on the 
Query/Label VPI option. 
 
Select existing VPI: <Pick the Red Circle at the FIRST bend in 
the vertical alignment> (zoom in if you need to, to be able to pick the red 
circle cleanly – don’t miss it) 
 
You will see the following dialog box. 
 

 
 
Be sure to pick the Label Curve box to turn it on.  Then pick the OK button 
to continue. 
 
The curve will be label as shown below: 
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Select existing VPI:<enter> 
 

Create Cross Section Template 
 
Before we create the template let us save the Vertical Design file; 
 
Go to the Design pulldown menu -> AutoRoute and pick on the Write .VRT 
File option. 
 
The command prompt will display the following to confirm it was saved. 
C:\Jobs2000\PGRID-0.VRT saved.
 
Now lets create a template for our road cross section. 
Go to the Design pulldown menu -> AutoRoute and pick on the Create 
Cross Section Template option. 
You will see a template editor on screen.  This editor has many options that 
need to be filled out. 
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Set each leg to the values shown. 
 

 
 

 
 

 
 
delete leg 4, 
 
Set the cut slope = 3.0 and fill slope = 2.0. 
Repeat legs 1 to 4 for the left side.  Once completed your template should look 
like the following. 
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Pick the SAVE and EXIT button. 
 
This will allow you to save the template for future use. 
Give the template the name of MAPLE, as shown. 
 

 
 
Pick the SAVE button to continue. 
 
The following message is placed in the command prompt window. 
Cross section template file saved as C:\Jobs2000\MAPLE.TMP. 
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Create New Road Surface 
 
Now that the cross section template is complete, we can now apply it to the 
design alignment.  Go to the Design pulldown menu -> AutoRoute and pick 
on the Create New Design Surface option. 
 
You will then see the following dialog box: 
 

 
 
Pick on our MAPLE template then pick the OPEN button to continue. 
 
The following dialog comes up next, 
 

 
 
You need to confirm the surface and alignment names match the box shown 
above.  Press the OK button. 
 
After a short period of time (a few seconds or so), the following prompt 
appears in the command window. 
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Draw or Show new TIN? Draw/Show/Noshow:
 
 <Pick SHOW to see the TIN> 
 
Your drawing should now look like this: 
 

 
 
After seeing the TIN you can hit the redraw button to clear the TIN.  The 
Surface does stay in memory for future use. 
 
What you will now see on screen is the road with the template applied, 
showing the outer edge where the template intersects with the original surface. 
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Output Cross Sections 

 
Now lets get some cross sections along the alignment. 
Go to the Design pulldown menu -> AutoRoute and pick on the Extract 
Cross Sections from Alignment option. 
 
Be sure to set the next dialog box exactly as shown below to ensure you get 
the correct results.  Special attention to ensure you select BOTH surfaces as 
shown. 
 

 
 
Pick the OK button to continue. 
 
This will draw lines on the plan view of the alignment to show where the cross 
sections will be extracted from. 
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Then: 
 

 
 
Answer NO. 
 

 
 
When you answer YES you will be shown another dialog box that controls the 
output of the sections.  Please fill it out exactly as shown: 
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Pick the OK button to continue. 
 
Pick lower left corner:  <this is the starting location for the sections to be 
drawn> (go to the right of the drawing so they do not overlap on screen) 
 
You will see the sheet size outlined and the sections draw within the sheet. 
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Changed the color of Layer GRID to gray (9) as we did above for the profile.  
Here is a close up of a few of the sections: 
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Be sure to save the drawing and the surfaces, as we covered in a previous 
tutorial. 
 
(End of tutorial) 
 

 
 

Getting Started in MicroSurvey CAD 2002  185 



 

 186  Getting Started in MicroSurvey CAD 2002 

House Placement Tutorial 
 
Because of the size and complexity of this tutorial we have broken it down 
into 9 smaller steps to make it easier for you to follow. 
 
Step 1) Open the Job 
 
Step 2) Working with the Toolbox 
 
Step 3) Entering a  Lot 
 
Step 4) Defining the Lot Sides 
 
Step 5) Entering a House 
 
Step 6) Defining a House 
 
Step 7) Placing a House on the Lot 
 
Step 8) Computing Stakes 
 
Step 9) Staking Reports 
 

Open the Job 
Make sure the Project Manager is set to work in the Jobs2000 folder.  If it is 
not then use the Set Project Directory button to choose the correct directory. 



 

 
 
We are going to start a NEW job called LOT  so pick on the NEW button and 
enter LOT as the job name.  Pick the OPEN button to continue.  
 

 
 
Next you will see the following dialog box. 
Set the defaults as shown here 
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At the bottom of the above dialog box, pick on the Toggles button.  This 
brings up the following dialog boxes. 
Set the Toggles as shown here. 
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Now pick the OK button to return to the previous dialog and pick OK again to 
exit and save the settings in that dialog box. 
 
If the MicroSurvey Assistant comes up on screen – pick the EXIT button to 
remove it from the screen. 

 
Working with the Toolbox 

 
Go to the MicroSurvey pulldown menu -> Subdivision / House Design and 
pick on the Open Subdivision Toolbox option. 
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The toolbox and can be dragged to any location on screen (by picking in the 
top bar in the Toolbox and while holding the mouse button down, drag it to the 
desired location) to make it easy to access but not cover the drawing. 
 

 
Entering a Lot 

Pick on this button:  
 
You will now be asked if you are entering a lot or block. 
 

 
 
In this example we will pick on the top button to enter a Lot. 

 
 
Now you will be asked which of the 3 different ways you wish to enter the lot 
information. 
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Pick on the first button:  
 
Now fill out the next dialog as show, with the lot number. 
 

 
 
Pick on the OK button to continue. 
 
You will then be given some reminders on how to enter your lot. 
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Pick on the OK button to continue. 
 
Now you will see the following dialog: 
 
 

 

There will be many things to enter on this 
dialog.  To start with you need to tell the 
routine if you are entering a line or curve – 
then press enter to continue.  Then you will 
be asked to fill in each piece of information 
on that line or curve.  Press enter after each 
piece of info has been entered. 

 
Here is what the first series of entries should look like: 
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After entering this info – press enter and 
you will be given the previous dialog 
again, ready for new numbers.  You will 
also see the lot taking shape in the 
drawing after each side is entered. 

 
 
 
Here are the remain pieces of information for you to enter:  Fill in everything, 
one step at a time as you go, and press enter after each item: 
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After you enter in all of the info on the last dialog – pick the FINISH button to 
continue. 
 
You will be presented with the following: 
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Pick the YES button to continue. 
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Defining the Lot Sides  
 
At this point you have the following lot drawn. 
 

 
 
The following dialog is on screen: 
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You need to pick on each of the 4 buttons labeled Front, Left, Rear and Right, 
one at a time and then pick the linework related to the button. 
 
To start, pick the FRONT button and then pick the first line we drew.  Then 
press enter to continue. 
 
Then pick the LEFT button and pick the second line we drew. Then press 
enter to continue. 
 
Then pick the REAR button and pick the first curve and the next line we 
drew. Then press enter to continue. 
 
Finally pick the RIGHT button and pick the second curve and last line we 
drew. Then press enter to continue. 
 
The lot sides should have changed color to match the buttons on the dialog, 
as shown below: 
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Pick the FINISH button to continue. 
 
Next a window will appear showing you the lot report. 

 
 
You may print it by going to the File pulldown menu in this window and 
picking the Print command. 
 
You may close the window by picking the X in the top right corner of the 
window. 
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Now you will be asked (and it may have been on screen already) 
 

 
 
Pick on NO to finish the lot entry. 
 

 
Entering a House 

Pick on this button:  
 
This will bring up the Building Library dialog. 

 
 
This dialog will display any structures already saved in the library and if you 
pick on one the preview will show up as well. 
Pick on the NEW button to add one. 
 
You will be given 2 different ways of entering house data. 
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We will pick on the first button to continue. 
 

 
 
Next give the house a name of Tutorial and pick the OK button to continue. 
 

 
 
At this point a new job is opened to allow you to create the house.  You will 
need to confirm the setup just like you do for other new drawings.  
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Match the entries in the above dialog and pick the OK button to continue. 
 
Similar to the lot entry, the following dialog is displayed as a reminder of how 
to enter the information. 
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Pick the OK button to continue. 
 
Pick each of the entries shown to define the units and direction the line is to be 
drawn in, and then press enter after each value is entered. 
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Pick the FINISH button to continue. 
 
You will see the following dialog: 
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Pick YES to continue. 
 

 
Defining a House 

 
At this point you have the following house drawn. 
 

 
 
The following dialog is on screen: 
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You need to pick on each of the 4 buttons labeled Front, Left, Rear and Right, 
one at a time and then pick the linework related to the button. 
 
To start, pick the FRONT button and then pick the first line we drew.  Then 
press enter to continue. 
 
Then pick the LEFT button and pick the second line we drew. Then press 
enter to continue. 
 
Then pick the REAR button and pick the next  3 lines we drew. Then press 
enter to continue. 
 
Finally pick the RIGHT button and pick the last line we drew. Then press 
enter to continue. 
 
Pick the FINISH button to continue. 
 
Your house has now been saved in the house library and you are returned to 
the Building Library dialog.  Pick on your house name and you will see the 
preview, as shown below: 
 

Getting Started in MicroSurvey CAD 2002  205 



 

 
 
Pick the Exit Building Library button to continue. 
 

 
Placing a House on the Lot 

 
Now we need to place the House on the Lot.  We do this by picking this button 
from the toolbox. 
 

 
 
It will bring up the following dialog box.  Fill it out as shown. 
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Once you pick the Insert Building button, the 
house we designed will now be attached to your 
crosshair and is ready for placement. 

 
NOTE: As you move the house around you can see the side ties update 
dynamically.  You can switch between rotating, translating and scaling the 
house by following the instructions on the dialog.  You may move the dialog 
out of the way by picking the top bar and dragging it to the side. 
 

 

You will see the house ties update as the house is 
moved in any direction, giving you the closest tie 
to the property line, in each direction 

 
 

Here are a couple of examples as we move the house around and rotate it to 
get what we desire. 
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Now we need to pick the desired location with the mouse, to place the house 
roughly on the lot. 
 

 

Once the house has been placed roughly on the 
lot, you will have the ability to fine-tune the exact 
location by using this “Tuner" dialog. 
 
You have course and fine control with the outer 
and inner directional buttons.  You can also 
specify the amount of movement for the two 
settings.  You may also rotate the house by the 
rotation arrows and even set the rotation based 
upon the angle between the house and the lot. 

 
 

 

You decide where you wish to place your house.  Mine is set as shown. 
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When you are happy with the final placement then pick the Place Building 
button to continue. 
 
Your house is now coordinated and points are placed on the house corners 
based upon the starting number and elevations set earlier. 

 
Computing Stakes 

 
Now that you have the house on the lot, we need to add a few stakes to make it 
easier for the construction crew to layout the house in the field. 
 
We will add a few stakes around the footprint of the house, offset back from 
the actual footprint.  To do this we will go to the MicroSurvey pulldown 
menu  Coordinate Point Utilities and pick the Compute Stakes option.  
Set the starting point number and offsets as shown below: 
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Pick the OK button to continue. 

 
 
The following dialog box will now appear to let you choose the method of 
placing stakes. 
 

 
 
Pick this button to place stakes at the building corners, offset from each line. 
 

 
 
Now you will see the following dialog box: 
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Confirm the starting point number and offsets 
and elevation of the points you are about to 
place.   

 
Then pick the house sides where you wish to place points. Pick the sides so 
that you get points as shown below:  (The white window at the top of the 
dialog box will give you instructions to walk you through placing points) 
 

 
 
Pick the STOP button to end placing new points and return to the previous 
dialog.  Set other points if you desire, by using some of the other routines. 
 
Pick the OK button to end the command. 
 

Staking Reports 
 
Now that we have some stakes set, we need to generate a staking report for the 
field crew. 
 
Go to the MicroSurvey pulldown menu  Print / Edit / View Reports and 
pick on the Stakeout Report option. 
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You will see the following dialog box: 

 
 

 

In the small white rectangle, enter in the point 
range for the stakes.  In my example I typed 
500..505  
 
Then pick the + sign to the right. 

 
The points on screen should now have little yellow X’s on them, like this: 
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Now pick on the Coordinate Point Report button. 
Then confirm the report file location and name: 
 

 
 
Pick the OK button to continue. 
 
The coordinate report is created and displayed in our editor.  You may print 
this report by going to the File pulldown menu  Print. 
 

 
 
You may close the window by picking the X in the top corner of the window. 
 
Now pick on the Angle/Distance Report button. 
Then confirm the report file location and name: 
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Pick the OK button to continue. 
 
 

 

Enter in the setup and backsight point numbers 
as show, and pick on the sorting method (we 
will do Angle first then Number), then pick on 
the Add Shots button. (now do the Number 
option and pick Add Shots again) 

 
The drawing will have yellow lines from the setup to each stake.  They are 
temporary and will be removed with a redraw or zoom command. 
 

 
 
Now pick the View Report button to see the two reports we generated. 
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The first was sorted by Angles the second by Point Numbers. 
 
You may print this report by going to the File pulldown menu (in this 
window) and pick the Print option. 
 
You may close the window by picking the X in the top corner of the window. 
 
Pick the OK button to continue. 
 
Save your job by going to the File pulldown menu and picking on the SAVE 
option. 
 
(End of tutorial) 
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